
SonicWall Network Security Manager 2.3
Release Notes
These release notes provide information about the SonicWall Network Security Manager (NSM) 2.3 release.

Versions:

l Version 2.3.5-8
l Version 2.3.5-7
l Version 2.3.5-6
l Version 2.3.5-5
l Version 2.3.5-4
l Version 2.3.5-3
l Version 2.3.5-2
l Version 2.3.5-1
l Version 2.3.5
l Version 2.3.4-15
l Version 2.3.4-14
l Version 2.3.4-13
l Version 2.3.4-12
l Version 2.3.4-11
l Version 2.3.4-10
l Version 2.3.4-9
l Version 2.3.4-8
l Version 2.3.4-7
l Version 2.3.4-6
l Version 2.3.4-5
l Version 2.3.4-4
l Version 2.3.4-3
l Version 2.3.4-2
l Version 2.3.4-1
l Version 2.3.4
l Version 2.3.3-9
l Version 2.3.3-8
l Version 2.3.3-7
l Version 2.3.3-6
l Version 2.3.3-5-Hotfix1
l Version 2.3.3-5
l Version 2.3.3-4
l Version 2.3.3-3
l Version 2.3.3-2
l Version 2.3.3-1
l Version 2.3.3
l Version 2.3.2-Hotfix 7
l Version 2.3.2-Hotfix 6
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l Version 2.3.2-Hotfix 5
l Version 2.3.2-Hotfix 3
l Version 2.3.2-Hotfix 2
l Version 2.3.2-Hotfix 1
l Version 2.3.2
l Version 2.3.1
l Version 2.3

Version 2.3.5-8
November 2023

Compatibility and Installation Notes
l Most popular browsers are supported, but Google Chrome is preferred for the real-time graphics display
on the Dashboard.

l AMySonicWall account is required.

What's New
This maintenance release provides fixes for previously reported issues.

Resolved Issues
Issue ID Issue Description

NSM-21307 Performing management tasks is not possible for units in NOAM account. Users
receive Tenant errors for management tasks, such as Commits.

NSM-21276 Unable to login to Cloud NSM using main account email from CSC tile page.

NSM-21268 Action Objects page is still displayed when the Objects permission is set to
Disabled.

NSM-21155 CTA report generated with wrong time range.

NSM-21136 Network Monitor Gateway/Interface sorting is out of order with interfaces in
double digits X10.

NSM-21135 Report drill down to Analytics show "No Data" under session logs when using
custom 30day time frame.

NSM-21020 All Geo-IP blocked traffic is not being displayed for one unit.

NSM-21012 NSM essentials unit is not displaying report data.

2Network Security Manager Release Notes
SonicWall Network Security Manager 2.3



Issue ID Issue Description

NSM-20922 NSM show differences in access rules when no changes have been made to unit
since it last synced.

NSM-20836 Custom Filter Scheduled reports show no data, whereas NSM shows this filtered
data.

NSM-19802 Cannot see SSHmanagement rule in NSM after enabling it on interface.

NSM-19609 NSM Hub and Spoke VPN Topology can't create route policies.

Known Issues
Issue ID Issue Description

NSM-21385 VPN Policy update commit push shows successful in NSM but the configuration is
not updated on firewall.

NSM-20863 NSM constantly preempting administrator while attempting to manage device
locally.

NSM-14943 Date picker for firmware upgrade is not working in Safari.

Additional References
NSM-21243, NSM-21169, NSM-21165, NSM-20947.

Version 2.3.5-7
October 2023

Compatibility and Installation Notes
l Most popular browsers are supported, but Google Chrome is preferred for the real-time graphics display
on the Dashboard.

l AMySonicWall account is required.

What's New
This maintenance release provides fixes for previously reported issues.
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Resolved Issues
Issue ID Issue Description

NSM-21062 Unable to create VPN Template with Serial Number or Firewall Name variables.

NSM-20979 Analytics>Devices report is displaying a high volume of traffic as 0.0.0.0.

NSM-20862 Reset request for Log Download limit error.

NSM-20743 30 days Analytics reports loads very slow or shows "No Data".

NSM-20615 Monitor->System Events->Authentication Logs->User Logins is only showing
data for last 2 days.

NSM-20034 Unit acquisition fails with error "Code":1,"Message":"Failed to sync config with
device (serial number XX)".

NSM-19779 Geo IP template is not applying allowed countries correctly on SOHOW from NSM.

Known Issues
Issue ID Issue Description

NSM-21020 Not all Geo IP blocked traffic is being displayed for one unit.

NSM-20922 NSM shows difference in access rules when no changes have been made to unit
since it last synced.

NSM-20836 Custom Filter Scheduled reports show no data, whereas NSM shows this filtered
data.

NSM-20622 NSM doesn't gray out disabled Static Routes.

NSM-19802 Unable to see SSHmanagement rule in NSM after enabling it on interface.

NSM-19137 CFS Blocked total count under Report>Details does not match Analytics session logs
total count.

Additional References
NSM-21134, NSM-20907, NSM-19686.
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Version 2.3.5-6
September 2023

Compatibility and Installation Notes
l Most popular browsers are supported, but Google Chrome is preferred for the real-time graphics display
on the Dashboard.

l AMySonicWall account is required.

What's New
This maintenance release provides fixes for previously reported issues.

Resolved Issues
Issue ID Issue Description

NSM-20505 Firewall>Device>License page does not show max license counts as seen in the
Firewall.

NSM-20489 Getting error "Command 'source zone All' does not match" while changing CFS
Source Zone from LAN to ALL in NSM.

NSM-20446 Source Port Remap option is disabled when creating new NAT policy in NSM.

NSM-20409 Unable to update a Local User password from NSM for a Gen6 firewall.

NSM-20303 Unable to utilize VPN Topology and getting error "Cannot set properties of
undefined(setting 'protectedNetworks')".

NSM-20246 Incorrect Custom Report timeline data when drilling down.

NSM-20243 VPNMesh Topology - Topology deployment is stuck in progress with no errors.

NSM-20241 Executing the Commit created by template disconnects the unit from ZT/IC.

NSM-20240 Larger DHCP configurations can result in error when applying template "Already
Exists".

NSM-20232 AppFlow SFR settings are not exported correctly to template.

NSM-20231 Getting "Already Exists" error for Auto Added SD-WAN probe settings when
applying template to Firewall with default settings.

NSM-19911 Frequent device up and down alerts from NSM.
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Issue ID Issue Description

NSM-18946 Template Config AppControl Signature/Name mismatch after NSM/Gen7
signature update.

NSM-15814 The viruses detected are not showing as blocked in NSM as well as scheduled report.

Known Issues
Issue ID Issue Description

NSM-20922 NSM shows difference in access rules when no changes have been made to unit
since it last synced.

NSM-20836 Custom Filter Scheduled reports show no data, whereas NSM shows this filtered
data.

NSM-20743 30 days Analytics reports loads very slow or shows "No Data".

NSM-19609 NSM Hub and Spoke VPN Topology can't create route policies.

NSM-19137 CFS Blocked total count under Report>Details does not match Analytics session logs
total count.

Additional References
NSM-20447, NSM-20398, NSM-20242, NSM-20094.

Version 2.3.5-5
August 2023

Compatibility and Installation Notes
l Most popular browsers are supported, but Google Chrome is preferred for the real-time graphics display
on the Dashboard.

l AMySonicWall account is required.

What's New
This maintenance release provides fixes for previously reported issues.
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Resolved Issues
Issue ID Issue Description

NSM-20285 Firewall Storage Logs are not displaying in NSM firewall view.

NSM-20066 Unable to login to NSM.

NSM-20026 Exporting capture file displays error in file, when using Packet Monitor in Switch to
firewall context.

NSM-20025 Packet Details are not displayed in Packet Monitor.

NSM-20024 Create Access Rule Dialogue does not have the same options enabled by default
as the firewall.

NSM-20011 HA firmware upgrade is failing while secondary is active.

NSM-20008 NAT Policy search is not working 100% of time.

NSM-20005 NSM filter for NAT policies does not display results.

NSM-20004 30 day analytic data is not loading.

NSM-19965 Report is missing when the secondary firewall becomes active.

NSM-19635 CTA scheduled report is failing with error "Failed(Valid PDF download link is not
found in CTA Response. [serial no.])".

NSM-19493 Unable to copy paste into Template values with the "Select Variable" Icon next to it.

Known Issues
Issue ID Issue Description

NSM-20303 Unable to utilize VPN Topology and getting error "Cannot set properties of
undefined(setting 'protectedNetworks')".

NSM-20246 Incorrect Custom Report timeline data when drilling down.

NSM-20243 VPNMesh Topology - Topology deployment is stuck in progress with no errors.

NSM-19725 Secondary Active firewall shows "Out-Of-Sync" and unmanaged right after
failover.

NSM-19609 NSM Hub and Spoke VPN Topology can't create route policies.

NSM-18342 Page loading for firewall IPSec VPN and editing any VPN is very slow even with
Hotfix.

NSM-15814 The viruses detected are not showing as blocked in NSM as well as scheduled
report.

NSM-14943 Date picker for firmware upgrade is not working in Safari browser.

NSM-14067 NSM is detecting good verdicts from Capture ATP as a virus, which is false positive.
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Additional References
NSM-20050, NSM-19927, NSM-19812, NSM-19368.

Version 2.3.5-4
August 2023

Compatibility and Installation Notes
l Most popular browsers are supported, but Google Chrome is preferred for the real-time graphics display
on the Dashboard.

l AMySonicWall account is required.

What's New
This maintenance release provides fixes for previously reported issues.

Resolved Issues
Issue ID Issue Description

NSM-20116 Unable to edit IPv4 Failover & LB group settings after 2.3.5-3-R27 upgrade.

NSM-19979 The interface value is blank after creating a route policy using the tunnel interface.

NSM-19715 After changing the LB group type from Basic to Ratio, the Edit option for
<interface> probe settings becomes non functional.

NSM-19708 Productivity > Users > drill down to session log results in no data.

NSM-19687 IPSec VPN tunnels only show one destination network even when there are
multiple destination networks.

NSM-19634 On-Demand CTA report produces with wrong time range.

NSM-19608 Customer is receiving subscription reports for which they have not configured.

NSM-19606 Unable to modify Failover and LB Group configuration at firewall and template
view.

NSM-19596 Firmware upgrade failure.

NSM-19557 SSL-VPN user session time is not shown correctly in NSM reports.
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Issue ID Issue Description

NSM-19319 Analytics Drill Down is showing No Data between the June 5th to June 9th for a
specific unit.

NSM-14690 Add Access Rule Page fails for MAC and FQDN objects.

Known Issues
Issue ID Issue Description

NSM-20050 NAT Policy search function is not filtering objects that match search term.

NSM-20026 When using Packet Monitor within Switch to Firewall context feature; the export is
successful, but the data in the file displays and error message.

NSM-20025 Packet details (Decode and Hex Dump) are not displayed in the Packet Monitor.

NSM-20024 Create Access Rule dialog box should have the same options enabled by default
as the firewall user interface.

NSM-20011 Firmware upgrade fails for an HA pair while the secondary unit is active.

NSM-20004 30 days analytic data does not load.

NSM-19877 Acquisition for NSa 4700 and NSa 6700 HA devices is failing.

NSM-19802 Unable to see SSHmanagement rule in NSM after enabling it on interface.

NSM-19725 Secondary Active firewall shows "Out-Of-Sync" and "unmanaged" right after
failover.

NSM-19493 Unable to copy paste into Template values with the "Select Variable" Icon next to
it.

NSM-15814 The viruses detected are not showing as blocked in UI and in scheduled report.

Additional References
NSM-19631, NSM-19503, NSM-19412, NSM-9681.
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Version 2.3.5-3
July 2023

Compatibility and Installation Notes
l Most popular browsers are supported, but Google Chrome is preferred for the real-time graphics display
on the Dashboard.

l AMySonicWall account is required.

What's New
This maintenance release provides fixes for previously reported issues.

Resolved Issues
Issue ID Issue Description

NSM-19685 SDWANMonitor displaying in HTML source code when viewed from firewall
context.

NSM-19680 Users unable to log into NSM.

NSM-19637 HA Secondary License page shows error "Invalid authentication. SN and EPAID
do not match".

NSM-19607 Interface name is not displayed on editing a route policy created for VPN tunnel
interface.

NSM-19595 Template change for WAN LB Spillover Kbit/s value is defaulted when modifying
the X1 Probe Targets.

NSM-19516 Unable to viewWAN group VPN session logs.

NSM-19501 When using the Switch to Firewall Context feature, customer is unable to delete
an IP address fromMonitor or Display filter.

NSM-19376 Changing the LB group type from Basic to Ratio and performing c and d, resets
the default target IP of <interface> probe settings to 0.0.0.0 in firewall and in NSM
it shows some default IP 204.212.170.23.

NSM-19346 The Custom Scheduled Monthly Report fails: AnalyzerNGOfflineClient :
UNAVAILABLE: upstream request timeout.

NSM-18475 VPN Topology > IPSec Monitor does not display Mesh Tunnel/s.
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Issue ID Issue Description

NSM-17093 VPN Topology shows the tunnel is down in NSM, but it shows up under the firewall
view.

Known Issues
Issue ID Issue Description

NSM-20050 NAT Policy search function is not filtering objects that match search term.

NSM-20026 When using Packet Monitor within Switch to Firewall context feature; the export is
successful, but the data in the file displays and error message.

NSM-20025 Packet details (Decode and Hex Dump) are not displayed in the Packet Monitor.

NSM-20024 Create Access Rule dialog box should have the same options enabled by default
as the firewall user interface.

NSM-20011 Firmware upgrade fails for an HA pair while the secondary unit is active.

NSM-19979 The interface value is blank after creating a route policy using the tunnel interface.

NSM-19802 Unable to see SSHmanagement rule in NSM after enabling it on interface.

NSM-19725 Secondary Active firewall shows "Out-Of-Sync" and "unmanaged" right after
failover.

NSM-19715 After changing the LB group type from Basic to Ratio, the Edit option for
<interface> probe settings becomes non functional.

NSM-19708 Productivity > Users > drill down to session log results in no data.

NSM-19634 On-Demand CTA report produces with wrong time range.

NSM-19606 Unable to modify Failover and LB Group configuration at firewall and template
view.

NSM-19557 SSL-VPN user session time is not shown correctly in NSM reports.

NSM-19503 System Events search is failing when search time line is set to 30 days or custom
dates.

NSM-19493 Unable to copy paste into Template values with the "Select Variable" Icon next to
it.

NSM-19137 CFS blocked total count under Report > Details does not match the analytics
session logs total count.

NSM-18342 Page loading for firewall IPSec VPN and editing any VPN is very slow even with
Hotfix.

11Network Security Manager Release Notes
SonicWall Network Security Manager 2.3



Version 2.3.5-2
July 2023

Compatibility and Installation Notes
l Most popular browsers are supported, but Google Chrome is preferred for the real-time graphics display
on the Dashboard.

l AMySonicWall account is required.

What's New
This maintenance release provides fixes for previously reported issues.

Resolved Issues
Issue ID Issue Description

NSM-19632 More frequent firewall administration sessions started from NSM after the 2.3.5-1
release.

NSM-19585 Synchronization fails when the HA secondary is active.

NSM-19513 Report data for 7 day and 30 day is slow and does not load any data.

NSM-19488 Cannot create or modify route policy for tunnel interface VPN.

NSM-19390 Bandwidth Management settings causing commits to WAN interface to fail.

NSM-19341 TZ270W and TZ600 firmware upgrades are giving and error in EMEA colo:
Firmware image signature could not be authenticated.

NSM-19254 Customer is getting CTA emails from tenants with no configured CTA reports.

NSM-19182 Custom date range in system events fails with Invalid Date Time Selected.
NSM-19153 Template for Geo-IP country list does not apply all countries for Gen6 firewalls.

NSM-19107 The Analytics filter of a certain responder country also displays unknown country
data.

NSM-19069 CTA report shows random blank pages.

NSM-18992 Upgrading firmware for an HA pair results in network downtime.

NSM-18863 Auto commits are getting created by NSM when customer visits the Firewall
View > Device > Users > Status page
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Issue ID Issue Description

NSM-18430 NSM CTA Report shows that Capture ATP is not licensed and shows no CTA
data when firewall is actually licensed.

NSM-17521 When drilling down on something blocked by CFS, the report shows the sites are
allowed.

Known Issues
Issue ID Issue Description

NSM-19557 SSL-VPN user session time is not shown correctly in NSM reports.

NSM-19516 Unable to viewWAN groupVPN session logs.

NSM-19503 System Events search is failing while search time line is set to 30 days or
Custom Dates.

NSM-19501 When using the Switch to Firewall Context feature, customer is unable to delete
an IP address fromMonitor or Display filter.

NSM-19493 Unable to copy and paste values that have the Select Variable icon next to it into
the template.

NSM-19346 The Custom Scheduled Monthly Report fails: AnalyzerNGOfflineClient :
UNAVAILABLE: upstream request timeout

NSM-19137 The total count of CFS Blocked items on the Report > Details page does not
match the total count on the Analytics session logs.

NSM-18475 VPN Topology >I PSec Monitor does not displayMesh Tunnel/s.
NSM-18342 System responds very slowly when loading the firewall IPSec VPN page and

when editing any VPN, even with the hotfix.

NSM-17093 VPN Topology shows the tunnel is down in NSM, but it show up under the firewall
view.

Version 2.3.5-1
June 2023

Compatibility and Installation Notes
l Most popular browsers are supported, but Google Chrome is preferred for the real-time graphics display
on the Dashboard.

l AMySonicWall account is required.
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What's New
This maintenance release provides fixes for previously reported issues.

Resolved Issues - NSM SaaS
Issue
ID Description

NSM-
19299

Acquisition is failing with error "context deadline exceeded".

NSM-
19279

CSR export appears successful, but exported p10 file does not contain valid data.

NSM-
19227

Synchronize task is not updating the Management status, online devices showing
UnManaged status.

NSM-
19206

Firewalls unable to acquire in NSM using IC.

NSM-
18992

Upgrading firmware for an HA pair results in network downtime.

NSM-
18966

Unable to edit IPv4 failover & LB group settings after 2.3.4-15 upgrade.

NSM-
18944

When attempting to custom filter on Logs & Alerts>Events, the NSM continues to display log
events from outside the custom filter time frame.

NSM-
18929

VPN Topology Spoke/Full Mesh/Partial Mesh Local Network selection does not
include/reference current firewall address objects.

NSM-
18927

Errors received when attempting to apply Templates exported from firewall settings.

NSM-
18875

Blocked websites are not shown in Analytics data.

NSM-
18825

Interfaces are still not showing the link status on NSM for redundant ports.

NSM-
18822

Upgrading TZ270/TZ370/TZ670 models with MSW hosted image fails with error.

NSM-
18477

VPN Topology, unable to add device to existing Mesh topology.

NSM-
18454

When making config change onWAN Failover LB group from Basic > Ratio, the WAN
interface/s probe settings, Main/Alternate target host IPs are removed.

NSM-
16318

Unable to login to NSM using Safari browser on iOS

NSM-
14687

Active tunnels tab does not display a created timestamp
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Known Issues NSM SaaS
Issue ID Description

NSM-19182 Custom date range in system events fail with "Invalid Date Time
Selected".

NSM-19153 Template for Geo-IP country list does not apply all countries for Gen6
firewalls.

NSM-19137 CFS blocked total count under Report>Details does not match analytics
session logs total count.

NSM-19107 Analytics filter of certain responder country also displaying unknown
country data.

NSM-19069 CTA report showing random blank pages.

NSM-18863 Auto commits are getting created by NSM when customer visits the
Firewall View->Device->Users->Status page.

NSM-18430 NSM CTA report showing Capture ATP not licensed and no CTA data
even when firewall is licensed.

NSM-17521 Blocked by CFS drill down shows sites that are allowed.

NSM-15814 The viruses detected are not showing as blocked in UI and in scheduled
report.

NSM-14943 Date picker for firmware upgrade not working in safari

Additional References
NSM-19230, NSM-19128, NSM-19091, NSM-19089, NSM-18862.

Version 2.3.5
May 2023

Compatibility and Installation Notes
l Most popular browsers are supported, but Google Chrome is preferred for the real-time graphics display
on the Dashboard.

l AMySonicWall account is required.
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What's New
l Alerts Enhancements: New alerts such as Interface Up/Down, WAN Failover, etc. are added to the alert
settings page so that admins can get informed about critical device events of all devices within in a tenant
and take corrective actions. VPN alert is also available on a per device level with NSM Advanced license.

l Firewall Management Status: NSM 2.3.5 accurately detects and displays the firewall
online/offline/managed/unmanaged status in NSM firewall inventory.

l Tenant and Group level Productivity reports: Admins can view the productivity reports containing the
users' Internet usage data, aggregated at the group and tenant levels. Productivity reports requires NSM
Advanced license.

l User Authentication reports for Gen 7 firewalls: Authentication reports provide information on
users/admins attempting to access the Firewall. This feature works for Gen 7 devices only with NSM
Advanced license with System events enabled.

l Support for IPv6 logs in Reports and Analytics: NSM now supports IPv6 logs from the firewalls in the
existing reporting and analytics features. This feature requires NSM Advanced license.

l System Events support for Gen 6: System events are supported on Gen 6 devices as well. System
events can be used by the admins for troubleshooting issues. This feature requires NSM Advanced
license.

l Interface-based data usage reports for Gen 7 firewalls: Interface-based data usage feature provides
live monitoring of ingress/egress data going through each interface. This feature works for Gen 7 devices
only and NSM Advanced license.

NOTE: All the above features require a firmware upgrade to work. Please upgrade your firewalls to
the following versions and re-configure Reporting and Analytics after upgrading for NSM Advanced
features:
GEN7 Firewalls: SonicOS 7.0.1-5119 or higher
GEN6 Firewalls: SonicOS 6.5.4.12-101n--GEN6-3920-9n or higher (Gen 6 firmware isn't available
to download on mysonicwall download center. Please contact support team to get this firmware build.)

Resolved Issues - NSM SaaS
Issue ID Description

NSM-
18994

Issues with Analytics data loading slowly after 2.3.4-15 upgrade for 7 and 30 days

NSM-
18899

No commit created for the reporting setup and missing the "Reconfigure Reporting &
Analytics" action option from the NSM Inventory page.

NSM-
18786

CTA scheduled reports fail for error "Failed(Valid PDF download link is not found in CTA
Response. [serial no.])".

NSM-
18678

Modifying a custom route directly on the firewall and then editing on NSM results in route
being disabled.
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Issue ID Description

NSM-
18571

Interface name not displayed on editing a route policy created for VPN tunnel interface.

NSM-
18569

NSM inventory page status not getting updated automatically until we click refresh.

NSM-
18566

Analytics is failing or intermittent for most selected time frames.

NSM-
18494

Intermittently, report data does not load when filtering for 90 days.

NSM-
18493

Missing data for certain IP when filtering by IP.

NSM-
18476

Unable to select newly created address object for VPN policy.

NSM-
17968

NSM unauthorized access.

NSM-
17542

Live reports and monitor does not display all vlan interfaces.

NSM-
17541

Scheduled flow report for live monitor does not display vlan interfaces on graphs.

NSM-
17522

Blocked CFS sites are not listed under analytics logs section.

NSM-
16385

The blocked CFS websites are not listed under "Monitoring - Blocked" page.

NSM-
15147

Mismtach in data transferred between the Carrier report and NSM.

Known Issues NSM SaaS
Issue ID Description

NSM-18992 Upgrading firmware for an HA pair results in network downtime.

NSM-18966 Unable to edit IPv4 failover & LB group settings after 2.3.4-15 upgrade.

NSM-18929 VPN Topology Spoke/Full Mesh/Partial Mesh Local Network selection does
not include/reference current firewall address objects.

NSM-18875 Blocked websites are not shown in Analytics data.

NSM-18863 Auto commits are getting created by NSM when customer visits the Firewall
View->Device->Users->Status page.

NSM-18825 Interfaces are still not showing the link status on NSM for redundant ports.

NSM-18822 Upgrading TZ270/TZ370/TZ670 models with MSW hosted image fails with
error.
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Issue ID Description

NSM-18568 Zero-touch status is shown in error state under "Management Status" when
secondary firewall is connected to NSM.

NSM-18475 VPN Topology>IPSec Monitor does not display Mesh Tunnel/s.

NSM-18430 NSM CTA report showing Capture ATP not licensed and no CTA data even
when firewall is licensed.

NSM-17521 Blocked by CFS drill down shows sites that are allowed.

NSM-15814 The viruses detected are not showing as blocked in UI and in scheduled report.

Additional References
NSM-19043, NSM-18623, NSM-18596, NSM-18572, NSM-16255.

Version 2.3.4-15
May 2023

Compatibility and Installation Notes
l Most popular browsers are supported, but Google Chrome is preferred for the real-time graphics display
on the Dashboard.

l AMySonicWall account is required.

What's New
This maintenance release provides fixes for previously reported issues.

Resolved Issues - NSM SaaS
Issue ID Description

NSM-
18597

Not able to view any report under Manager View>Monitor>Suammary/Details/Analytics.

NSM-
18468

Commit failure when modifying X0 interface.
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Issue ID Description

NSM-
18467

DHCP advanced commit failure.

NSM-
18405

Configuration management audit failure.

NSM-
18386

Live report has no data for 30 days.

NSM-
18350

Changes made to DNS search list are not displayed until commit is deployed

NSM-
18349

NSM does not properly configure or display the configure external storage feature.

NSM-
18323

While using filtered time frame on system events, events that would fall outside the time
frame are getting displayed.

NSM-
18299

Grouped firewalls appear as "Unassigned" in device inventory page.

NSM-
18172

Synchronization fails when HA secondary unit is active.

NSM-
18099

Missing report data for intermitent dates/times.

Known Issues NSM SaaS
Issue ID Description

NSM-18678 Modifying a custom route results in route getting disabled.

NSM-18571 Interface name not displayed on editing a route policy created for VPN tunnel
interface.

NSM-18494 Intermittently, report data does not load when filtering for 90 days.

NSM-18493 Missing data for certain IP when filtering by IP.

NSM-18475 VPN Topology>IPSec Monitor does not display Mesh Tunnels.

NSM-18454 Gen6 failover LBWAN interface probe settings modified when ratio is
modified.

NSM-18342 Page loading for firewall is very slow even with Hotfix.

NSM-17542 Live reports and monitor does not display all Vlan interfaces.

NSM-17541 Scheduled flow report for live monitor does not display Vlan interfaces on
graphs.

NSM-17093 VPN topology shows tunnel down in NSM but up under firewall view.

NSM-15814 The viruses detected are not showing as blocked in UI and in scheduled reports.
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Version 2.3.4-14
April 2023

Compatibility and Installation Notes
l Most popular browsers are supported, but Google Chrome is preferred for the real-time graphics display
on the Dashboard.

l AMySonicWall account is required.

What's New
This maintenance release provides fixes for previously reported issues.

Resolved Issues - NSM SaaS
Issue ID Description

NSM-
18358

PPPoEWAN interface configuration fails when using Template exported from firewall
settings.

NSM-
18357

Editing the interface of a route policy results in policy being disabled and interface setting is
not changed.

NSM-
18227

Productivity report is not displaying data on random dates.

NSM-
18128

Applying golden template created by customer firewall setting, throwing schema validation
error.

NSM-
17762

Reporting/Analytics data missing websites.

NSM-
17635

Attempting to configure OSPFv2/3 settings throw invalid type/tag ID error.

NSM-
17541

Scheduled flow report for live monitor does not display vlan interfaces on graphs.

NSM-
16934

App risk numbers in capture threat assessment report don’t match NSM flow report.

20Network Security Manager Release Notes
SonicWall Network Security Manager 2.3



Additional References
NSM-18455, NSM-18245, NSM-18242, NSM-17542.

Version 2.3.4-13
April 2023

Compatibility and Installation Notes
l Most popular browsers are supported, but Google Chrome is preferred for the real-time graphics display
on the Dashboard.

l AMySonicWall account is required.

What's New
This maintenance release provides fixes for previously reported issues.

Resolved Issues - NSM SaaS
Issue ID Description

NSM-
18236

Under Live Reports for Application Bandwidth the metric used on y-axis displays
Connections.

NSM-
18230

Session logs are not loading for NOAM colo.

NSM-
18053

Gen6 failover- LBWAN interface probe settings is modified when changing to Ratio.

NSM-
17635

OSPFv2/v3 metric type cannot be committed and gets error for invalid ID Tag.

NSM-
17531

NSM VPN is not coming up.

NSM-
17525

Golden template application to target firewall is getting error "CUSoCalSNMPSonicWall
already exists. Please choose different name".

NSM-
17504

NSM Intrusion Details report is showing signature ID instead of name.
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Issue ID Description

NSM-
16230

Azure NSv firewall is still not showing VPN green lights in NSM.

Known Issues NSM SaaS
Issue ID Description

NSM-18172 Synchronization fails when HA Secondary unit is active.

NSM-18099 Report data is missing for intermittent dates/times.

NSM-17762 Reporting/Analytics data is missing websites.

NSM-17522 Blocked CFS sites are not listed under analytics logs section.

NSM-17521 Blocked by CFS drill down shows sites that are allowed.

NSM-15814 The viruses detected are not showing as blocked in NSM as well as scheduled report.

NSM-14943 Date picker for firmware upgrade is not working in safari.

Additional References
NSM-18194, NSM-18188.

Version 2.3.4-12
March 2023

Compatibility and Installation Notes
l Most popular browsers are supported, but Google Chrome is preferred for the real-time graphics display
on the Dashboard.

l AMySonicWall account is required.

What's New
This maintenance release provides fixes for previously reported issues.
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Resolved Issues - NSM SaaS
Issue ID Description

NSM-
17980

Custom scheduled monthly report is failing with error "AnalyzerNGOfflineClient :
UNAVAILABLE: upstream request timeout".

NSM-
17978

Reporting and Analytics Drill down with multiple filters results in no data.

NSM-
17959

SonicWall needs to be removed from NSM.

NSM-
17949

Websites report is showing "No Data" in Data Grid, if using custom time frame older than 1
month.

NSM-
17819

Commit is failing with error "internal error".

NSM-
17617

Every time a firewall lost WAN connection, an erroneous email alert is sent "Device has been
locally modified".

NSM-
17383

The template that is used to change SSH port on Gen6 is not working.

NSM-
17283

NSM is not displaying correct admin name.

NSM-
15552

License expired - false negative impression.

Known Issues NSM SaaS
Issue ID Description

NSM-18053 Gen6 failover LBWAN interface probe settings is modified when changing to Ratio.

NSM-17762 Reporting and Analytics data is missing websites.

NSM-17635 OSPFv2/v3 metric type cannot be committed and gets error for invalid ID Tag.

NSM-17542 Live reports and monitor does not display all Vlan interfaces.

NSM-17541 Scheduled Flow Report for live monitor does not display Vlan interfaces on graphs.

NSM-17522 Blocked CFS sites are not listed under analytics logs section.

Additional References
NSM-18071, NSM-17981, NSM-17652.
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Version 2.3.4-11
March 2023

Compatibility and Installation Notes
l Most popular browsers are supported, but Google Chrome is preferred for the real-time graphics display
on the Dashboard.

l AMySonicWall account is required.

What's New
This maintenance release provides fixes for previously reported issues.

Resolved Issues - NSM SaaS
Issue ID Description

NSM-17818 NSM live report chart and PDF is reporting inconsistent unit for bandwidth.

NSM-17690 Analytics data is loading very slow when trying to pull the data for 30 days.

NSM-17674 Interface bandwidth usage shows low under Live Reports when checking for 30 days.

NSM-17615 Getting "failed to get commit" error when expanding details of a Commit.

NSM-17538 Website reports are randomly not associating data to IPs and are showing Source IP as
0.0.0.0.

NSM-16754 NSM CTA report is not showing Capture ATP data.

Known Issues NSM SaaS
Issue ID Description

NSM-17819 Commit is failing with error "internal error".

NSM-17762 Reporting and analytics data is missing websites.

NSM-17542 Live reports and monitor is not displaying all Vlan interfaces.

NSM-17504 NSM intrusion details report is showing signature ID instead of name.

NSM-17383 The template that is used to change SSH port on Gen6 is not working.
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Additional References
NSM-17874, NSM-17598, NSM-17063.

Version 2.3.4-10
February 2023

Compatibility and Installation Notes
l Most popular browsers are supported, but Google Chrome is preferred for the real-time graphics display
on the Dashboard.

l AMySonicWall account is required.

What's New
This maintenance release provides fixes for previously reported issues.

Resolved Issues - NSM SaaS
Issue ID Description

NSM-
17578

CTA reports scheduled/on-demand fail for 504 error.

NSM-
17502

Gaps are showing in Live Report charts for 24 hrs and above.

NSM-
17464

Destinations group by country is showing "?".

NSM-
17455

Getting error while changing the Failover and LB settings to use Spill-Over method.

NSM-
17382

Gen6 firewall is not showing SSH port.

NSM-
17346

Unable to select the Address object using VPN topology, when creating Address group for
Spoke.

NSM-
17282

Rejected changes were deployed.

25Network Security Manager Release Notes
SonicWall Network Security Manager 2.3



Issue ID Description

NSM-
17174

An error is displayed when navigating to Firewall View > Network > IPSec VPN > Rules and
Settings.

NSM-
16833

No data in NSM when firewall fails over to secondary or if secondary fails back to primary.

NSM-
15377

Imported firewall certificates are not available for SSL-VPN/firewall management on NSM
Firewall View.

NSM-
8225

After failover to secondary, the device shows down in the inventory (Issue is reproducible on
license reset/factory reset of the device).

Known Issues NSM SaaS
Issue ID Description

NSM-17093 VPN Topology shows Tunnel Down in NSM but Up under Firewall View.

NSM-16754 NSM CTA report is not showing Capture ATP data.

NSM-15814 The viruses detected are not showing as blocked in NSM as well as scheduled report.

NSM-15147 Mismatch in data transferred between the Carrier report and NSM.

Additional References
NSM-17481, NSM-17450, NSM-17284, NSM-17265, NSM-16970, NSM-16752.

Version 2.3.4-9
February 2023

Compatibility and Installation Notes
l Most popular browsers are supported, but Google Chrome is preferred for the real-time graphics display
on the Dashboard.

l AMySonicWall account is required.

What's New
This maintenance release provides fixes for previously reported issues.
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Resolved Issues - NSM SaaS
Issue ID Description

NSM-
17343

CTA report failed with error message "Failed to include PDF file as email attachment".

NSM-
17262

Issue while adding device from existing VPN topology.

NSM-
17250

Analytics data loading is very slow when pulling the data for 30 days.

NSM-
17245

Users in MySonicWall are not synchronized in NSM.

NSM-
17124

Interfaces are not showing the link status on NSM for redundant ports.

NSM-
17122

NSM is not showing the 1-hour slider on the Website Activities or Website Categories pages.

NSM-
16965

NSM report failing with error message "AnalyzerNGOfflineClient StatusRuntimeException :
UNAVAILABLE: upstream request timeout".

NSM-
16301

Data is missing in reports.

NSM-
16099

Unable to add more Device Groups from Firewalls > Groups in NSM.

Known Issues NSM SaaS
Issue ID Description

NSM-17464 Destinations group by country is showing "?".

NSM-17455 Getting error while changing the Failover and LB settings to use Spill-Over method.

NSM-17346 Unable to select the Address object using VPN topology, when creating Address group for
Spoke.

NSM-17284 There are gaps in report data for Gen7 HA firewalls.

NSM-17282 Rejected changes were deployed.

NSM-17174 An error displays when navigating to Firewall View > Network > IPSec VPN > Rules and
Settings.

NSM-17093 VPN Topology shows Tunnel Down in NSM but Up under firewall view.

NSM-15814 The viruses detected are not showing as blocked in NSM as well as scheduled report.

NSM-15147 Mismatch in data transferred between the Carrier report and NSM.
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Additional References
NSM-12097.

Version 2.3.4-8
January 2023

Compatibility and Installation Notes
l Most popular browsers are supported, but Google Chrome is preferred for the real-time graphics display
on the Dashboard.

l AMySonicWall account is required.

What's New
This maintenance release provides fixes for previously reported issues.

Resolved Issues - NSM SaaS
Issue
ID Description

NSM-
17125

An exported Scheduled Report does not show Live Monitor information (like Bandwidth,
Application, Packet Rate, Connection Rate, and so forth) older than one day.

NSM-
17038

Daily reports don't provide data for bandwidth usage, packet size, packet rate, and connection
rate.

NSM-
17014

The NSM CTA Report, Top countries by Traffic, appears blank.

NSM-
16971

Unable to add commentaries on the firewall interfaces via NSM.

NSM-
16340

Under Config Management > Audit, NSM is missing logs for some firewalls.

NSM-
15274

There are still some gaps in Data Usage seen for firewalls on NSM.
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Known Issues NSM SaaS
Issue ID Description

NSM-
17174

An error displays when navigating to Firewall > Network > IPSec VPN >Rules and
Settings.

NSM-
17122

NSM is not showing the 1-hour slider on theWebsite Activities orWebsite Categories
pages.

NSM-
16833

No data shows in NSM when a firewall fails over to secondary device or if the secondary fails
back to the primary device.

NSM-
16754

NSM CTA Report shows no Capture ATP data. Capture ATP may be either not licensed or
disabled.

NSM-
16099

Unable to add more Device Groups from Firewalls > Groups in NSM.

NSM-
15147

Mismtach in data that is transferred between the Carrier report and NSM.

Additional References
NSM-16970

Version 2.3.4-7
January 2023

Compatibility and Installation Notes
l Most popular browsers are supported, but Google Chrome is preferred for the real-time graphics display
on the Dashboard.

l AMySonicWall account is required.

What's New
This maintenance release provides fixes for previously reported issues.

29Network Security Manager Release Notes
SonicWall Network Security Manager 2.3



Resolved Issues - NSM SaaS
Issue ID Description

NSM-17130 Headers on the system events and on the firewall logs are not same and few
of the headers are missing.

NSM-17087 Websites are missing in NSM flow report export.

NSM-16916 NSMWLB probe setting shows it to be "Disabled" even though it is enabled on
the firewall.

NSM-16914 SSO user web activities source/destination IP showing as 0.0.0.0.

NSM-16854 From > Firewall View > Mac IP antispoof > Anti spoof cache > Edit > Change
the Mac address. (Error: Mac_Ip_spoof_cache entry not found)

NSM-16789 Unable to enable/disable app control signature for Gen7 firewall.

NSM-16769 Live reports usage data not getting displayed on firewall added to NSM older
than 15th Nov.

NSM-16765 Users data missing under Productivity reports for users.

NSM-16755 NSM domain names for web traffic reports are missing.

NSM-16536 NSM CTA report failed with error message: Email action failed.

NSM-16377 Graphs show inconsistent/incorrect data within the alert configuration of
Firewall View>Monitor>Alerts&Notifications.

NSM-16249 The main and alternative target for failover and LB probe shows disabled in
NSM.

NSM-13727 NSM not displaying correct administrator name.

Known Issues NSM SaaS
Issue ID Description

NSM-17174 When going to Firewall View->Network->IPSec VPN->Rules and Settings, an
error is thrown.

NSM-17124 Interfaces are not showing the link status on NSM for redundant ports.

NSM-17122 NSM not showing website activities/categories in 1 hour slider.

NSM-17014 NSM CTA report showing top countries by traffic blank.

NSM-16833 No data in NSM when firewall fails over to secondary or if secondary fails back
to primary.

NSM-16754 NSM CTA report showing no capture ATP data.

NSM-16301 NSM SaaS reporting/analytics: Missing data in reports.

NSM-15814 The viruses detected are not showing as blocked in UI as well as in scheduled
report.
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Issue ID Description

NSM-15147 Mismatch in data transferred between the carrier report and NSM.

Version 2.3.4-6
December 2022

Compatibility and Installation Notes
l Most popular browsers are supported, but Google Chrome is preferred for the real-time graphics display
on the Dashboard.

l AMySonicWall account is required.

What's New
This maintenance release provides fixes for previously reported issues.

Resolved Issues - NSM SaaS
Issue ID Description

NSM-16843 Could not upgrade firewall firmware from NSM as the "Browse" button greys
out.

NSM-16792 Device>Settings>Administration configurations are not syncing from firewall.

NSM-16758 Password complexity on firewall view is showing wrong values.

NSM-16757 Cannot create less than 20 Mbps BWM objects.

NSM-16517 Unable to apply template in NSM SaaS with variables.

NSM-16326 Cannot import LDAP integrated users on the firewall from NSM.

NSM-16202 No report data is received in NSM while secondary is active.

NSM-16187 Mismatch in firmware version displayed on NSMmanagement status.

NSM-16147 For dynamic DHCP lease scope, default gateway entry is not getting pre-
populated when choosing interface pre-populate option.

NSM-15984 VPN tunnel with NSM is unable to come up so there is no date on report.

NSM-15822 Live monitoring showing (Bandwidth, Application, Packet rate etc) data screen
keeps spinning and times out.
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Issue ID Description

NSM-15337 Cannot click 'Cancel' in pop up dialogue when using 1440x795 resolution on
15.6" MacBook.

NSM-14398 Mismatch in Apprisk where applications that are blocked due to high risk are
categorized as low priority on the app control.

NSM-3974 VPN Tunnel Statistics does not show any data.

Known Issues NSM SaaS
Issue ID Description

NSM-16916 WLB probe setting shows as "Disabled" even though it is enabled on the
firewall.

NSM-16914 SSO user web activities source/destination IP shows as 0.0.0.0.

NSM-16789 Unable to enable/disable app control signature for Gen7 firewall.

NSM-16755 NSMmissing domain names for web traffic reports.

NSM-16377 Graphs show inconsistent/incorrect data within the alert configuration of
Firewall View>Monitor>Alerts&Notifications.

NSM-16249 Main and alternative target for Failover and LB Probe shows disabled in NSM.

NSM-15814 The viruses detected are not showing as blocked in NSM as well as scheduled
report.

NSM-15147 Mismatch in data transferred between the Carrier report and NSM.

Additional References
NSM-16866, NSM-16816, NSM-16798, NSM-16229, NSM-16192, NSM-16151, NSM-15114, NSM-14286.

Version 2.3.4-5
December 2022

Compatibility and Installation Notes
l Most popular browsers are supported, but Google Chrome is preferred for the real-time graphics display
on the Dashboard.

l AMySonicWall account is required.

32Network Security Manager Release Notes
SonicWall Network Security Manager 2.3



What's New
This maintenance release provides fixes for previously reported issues.

Resolved Issues - NSM SaaS
Issue ID Description

NSM-16825 Unable to enable DHCP on templates on NSM Cloud.

NSM-16751 Issue with incorrect date in the exported system event CSV file.

NSM-16736 The VPN topology IKE ID settings should be only used for aggressive VPN.

NSM-16729 User settings on firewall is not matching user settings listed on the firewall.

NSM-16644 Search does not return results for matched value in service column of access
rules.

NSM-16492 3 deployments are stuck at "Deploying" for months and could not be deleted.

NSM-16454 Unable to configure SSLVPN client setting's DNS search list.

NSM-16320 Export from inventory page is not showing correct IP address.

NSM-16250 NSM advanced shows not licensed on firewall on NSM that is licensed for
NSM advanced.

NSM-15992 NSM cannot enable/disable DHCPv4 server.

NSM-15735 NSM firmware upgrade is failing. It is only working if the firewall is manually
rebooted before the update.

NSM-15265 NSM Reporting - Click to Show Details doesn't display the description.

NSM-15196 Unable to generate report on NSM and no data is shows in charts as well.

NSM-15126 Unable to delete multiple certificates and getting error "504 Gateway Timeout".

Known Issues NSM SaaS
Issue ID Description

NSM-16843 Could not upgrade firewall firmware from NSM as the "Browse" button greys
out.

NSM-16792 Device>Settings>Administration configurations are not syncing from firewall.

NSM-16765 User data is missing under productivity reports for users.

NSM-16758 Password complexity on firewall view is showing wrong values.

NSM-16757 Cannot create less than 20 Mbps BWM objects.

NSM-16377 Graphs is showing inconsistent/incorrect data within the alert configuration of
Firewall View>Monitor>Alerts&Notifications.
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Issue ID Description

NSM-16326 Cannot import LDAP integrated users on the firewall from NSM.

NSM-16187 Mismatch in firmware version displayed on NSMmanagement status.

NSM-16099 Unable to add more device groups from Firewalls>Groups in NSM.

NSM-15822 Live monitoring showing (Bandwidth, Application, Packet rate etc) data screen
keeps spinning and times out.

NSM-15377 Imported firewall certificates is not available for SSL-VPN/firewall
management on NSM firewall view.

NSM-15147 Mismatch in data transferred between the Carrier report and NSM.

Additional References
NSM-16576, NSM-16545, NSM-16540, NSM-16366, NSM-16070, NSM-16043, NSM-15857, NSM-15661, NSM-
15448, NSM-7260.

Version 2.3.4-4
November 2022

Compatibility and Installation Notes
l Most popular browsers are supported, but Google Chrome is preferred for the real-time graphics display
on the Dashboard.

l AMySonicWall account is required.

What's New
This maintenance release provides fixes for previously reported issues.

Resolved Issues - NSM SaaS
Issue ID Description

NSM-16398 Data transfer shows zero data for websites in NSM portal.

NSM-16375 NSM template is accepting service object in decremental order.

NSM-16201 Local groups is showing blank page in NSM.
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Issue ID Description

NSM-16195 Tenant name in NSM is showing some other name.

NSM-16089 There is inconsistency in showing data under Firewall View>Monitor >System
Events.

NSM-16045 Customer is receiving CTA reports even though it's not created.

NSM-16044 NSM Flow Report Export is missing websites.

NSM-16041 NSM not showing website activities/categories in 1 hour slider.

NSM-15982 NSM is not able to sync with the firewall.

NSM-15901 No web activity related data is showing in NSM reports. Rest of the data can
be seen.

NSM-15817 There is data mismatch in CTA report and NSM Flow report.

NSM-15816 The virus names in NSM and scheduled report is not correct.

NSM-15090 Search function of Web Categories>Web Activities reports is inconsistent.

NSM-14843 App Control configuration is not in sync with GEN6 firewall. Blocked
applications are showing unblocked in NSM.

NSM-14667 App Risk numbers in Capture Threat Assessment report is not matching NSM
Flow report.

NSM-1061 Template: Editing existing route policy is creating duplicate routes.

Known Issues NSM SaaS
Issue ID Description

NSM-16751 There is issue with incorrect date in the exported system event CSV file.

NSM-16536 NSM CTA report failed with error message: Email action failed.

NSM-16454 Unable to configure SSLVPN client setting's DNS search list.

NSM-16377 Graphs show inconsideration data within the alert configuration of Firewall
View>Monitor>Alerts & Notifications.

NSM-16326 Cannot import LDAP integrated users on the firewall from NSM.

NSM-15822 Live monitoring showing data such as bandwidth, application, packet rate etc.
keeps spinning and times out.

NSM-15814 The viruses detected are not showing as blocked in NSM as well as scheduled
report.

NSM-15274 There are still gaps seen in data usage for firewalls on NSM.

NSM-15147 Mismtach in data transferred between the carrier report and NSM.

NSM-13727 NSM not displaying correct administrator name.
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Additional References
NSM-16428, NSM-16341, NSM-16191, NSM-15854, NSM-15278, NSM-15083.

Version 2.3.4-3
October 2022

Compatibility and Installation Notes
l Most popular browsers are supported, but Google Chrome is preferred for the real-time graphics display
on the Dashboard.

l AMySonicWall account is required.

What's New
l Golden Template Improvement: Previously, NSM appended any new changes in the golden template at
the end of the exported configurations which resulted in multiple issues. With this release, NSM will re-
generate the golden template configurations (APIs) from the latest configurations in the Template view
before applying it to the firewalls. This improvement will be useful for administrators who need to do further
edits or delete objects/policies on the Golden Template and want to push latest Golden Template
configuration to firewalls.

NOTE: All assigned interface (IPv4) settings will be generated during export regardless of whether
they belong to WAN zone or not. Administrators must configure right WAN interfaces for firewalls
respectively before applying the Golden Template configuration to avoid breaking the network
connection between NSM and firewalls once the Golden Template configurations are deployed.

Resolved Issues - NSM SaaS
Issue ID Description

NSM-16189 Scheduled reports fail if there is "/" in report name.

NSM-16168 On-Demand report shows incorrect report period.

NSM-16088 The usernames are printed as hexadecimal values in reports.

NSM-16061 No reports in NSM for Gen7 firewall.

NSM-15794 Not able to set Capture ATP to none on the exclusion list from NSM.
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Issue ID Description

NSM-15725 NSM Users are able to view User information from other Tenant firewall in the
Global "Monitor tab" module.

NSM-14755 NSM portal showing "NSM Advanced is not licensed" even though firewalls
are licensed with NSM Advanced.

NSM-14251 No data available under summary/details/analytics.

NSM-13214 Random set of numbers can be seen as entries under vpn reports.

NSM-7760 Uploading Firmware in Inventory is throwing success message but not upgrading
the device.

Known Issues NSM SaaS
Issue ID Description

NSM-16202 NSM reports/data is not received when secondary is active unit.

NSM-16201 Local Groups is showing blank page in NSM SaaS.

NSM-16147 For dynamic DHCP lease scope, default gateway entry is not getting pre-
populated even when we choose interface pre-populate option.

NSM-15901 Web Activity Related data not seen in NSM reports.

NSM-15817 Data mismatch in CTA report and NSM Flow report.

NSM-15814 The viruses detected are neither showing as blocked in the interface nor in
scheduled report.

NSM-15274 There are gaps in data usage seen for firewalls on NSM.

NSM-15147 Mismtach in data transferred between the carrier report and NSM.

NSM-14880 Secondary unit not getting acquired when failover happens in HA setup on NSM.

Additional References
NSM-16169, NSM-16098.
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Version 2.3.4-2
October 2022

Compatibility and Installation Notes
l Most popular browsers are supported, but Google Chrome is preferred for the real-time graphics display
on the Dashboard.

l AMySonicWall account is required.

What's New
This maintenance release provides fixes for previously reported issues.

Resolved Issues - NSM SaaS
Issue ID Description

NSM-15870 Unable to create more than 25 scheduled reports on NSM.

NSM-15830 Report generated for 30 days shows missing data.

NSM-15767 Scheduled report generated does not show chart for all the live reports.

NSM-15731 NSM VPN tunnel is not getting created.

NSM-15691 Bandwidth report constantly changes colors of reported interfaces.

NSM-15659 Assistance to remove Vtunnel from CTA report.

NSM-15397 Page loading for firewall IPSec VPN and editing any VPN functions are very
slow.

NSM-15340 Customer reported issue on point to point VPN configuration through NSM.

NSM-15146 On the Manager View>Dashboard>System page, unable to get the details of
expiring licenses when clicking on it.

NSM-14825 Web category/Websites reports are no showing for TZ500 with CFS enabled.

NSM-14794 Scheduled flow report type PDF has empty pages when some of the details
report has no data.

NSM-14612 Hub and spoke tunnel VPN topology creates wrong route policies.

NSM-13909 Incorrect responder location in analytic data is dispalyed.

NSM-13656 Virus information was seen earlier yesterday but no data was found after 6PM
yesterday.
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Known Issues NSM SaaS
Issue ID Description

NSM-15901 No web activity related data is seen in NSM reports, rest of the data can be
seen.

NSM-15878 GeoIP report shows connections and data transferred to blocked countries.

NSM-15822 Live monitoring screen, showing bandwidth, application, packet rate etc, does
not load data and times out.

NSM-15817 Data mismatch in CTA report and NSM flow report.

NSM-15816 The virus names in NSM interface and scheduled report is not correct.

NSM-15814 The viruses detected are not showing as blocked in the interface as well as
scheduled report.

NSM-15274 There are still gaps in data usage seen for firewalls on NSM.

NSM-15196 Unable to generate report on NSM and there is no data in charts.

NSM-15147 Mismtach in data transferred between the carrier report and NSM.

NSM-15090 Search function of web activities reports is inconsistent.

Additional References
NSM-15555.

Version 2.3.4-1
September 2022

Compatibility and Installation Notes
l Most popular browsers are supported, but Google Chrome is preferred for the real-time graphics display
on the Dashboard.

l AMySonicWall account is required.
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What's New in NSM SaaS
l NSM 2.3.4-1 is now integrated with an analytics tool to collect anonymized data to understand the user
interactions with NSM workflows better and improve the product utility by delivering relevant new features
using this data. Administrators will see a consent box to opt in/out of this feature on logging into NSM
where they can enable the “Allow NSM to collect anonymized usage data” button to opt in. They can
always enable or disable this option from the User Profile page at any time.

l Starting NSM 2.3.4-1, a user will be able to view System Event after upgrading GEN7 firewalls to SonicOS
7.0.1-5080 or higher and followed by re-configuring reporting and analytics. Please refer to the Reporting
and Analytics Guide for more details. To view System Event from a firewall in NSM, it should have NSM
advanced license.

Resolved Issues - NSM SaaS
Issue ID Description

NSM-15549 Configuring app control using template does not work.

NSM-15399 Current values and peak values for active connections are reversed between
the firewall and NSM.

NSM-15275 GEN6 Access Rules MAC and FQDNObjects are displayed improperly.

NSM-15165 Report generated for 30 days showing incorrect data.

NSM-15161 The IPS, Anti-Spyware, and Virus Signatures are showing IDs instead of their
respective names in the NSM report.

NSM-15157 Email alert for IPS showed signature ID instead of name, after NSM upgraded
to 2.3.3-9.

NSM-15156 When checking for time below 6 hrs, no data showing in reports except in Web
Categories.

NSM-14966 Beta-Active Connections Count is showing all 0s under Live Report and Live
Monitor.

NSM-14875 Active Connection Count shows blank graph under Monitor > Overview > Live
Monitor > SystemMonitor/Connection Usage.

NSM-14829 ICMP Code, ICMP Type, Destination NAT IP, and Session Type shows value
even if the value is blank in firewall.

NSM-14803 Data transfer shows Zero data for websites for last 24 hours in NSM portal.

NSM-14754 Web Categories or Website information does not show up if the filter is set for
1 Hour.

NSM-14750 Color coding does not show for the different types of system events.

NSM-14748 Search is not working in system events.

NSM-14620 Per-Interface alert is not being triggered when thresholds are met.

NSM-14604 Unable to select time frame while creating Rule on NSM.
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Issue ID Description

NSM-14355 Login to unit is not working for Gen6 with instant connect enabled.

NSM-9327 Firewall view is not showing all the IPS signatures that are showing in the
firewall GUI.

NSM-7277 Information missing on wireless dashboard.

Known Issues NSM SaaS
Issue ID Description

NSM-15822 Live monitoring screen keeps spinning and times out.

NSM-15816 Incorrect names are displayed for viruses in the NSM UI/Scheduled reports.

NSM-15725 NSM users are able to view user information from other Tenant firewall in the
Global Monitor tab module.

NSM-15691 Live Monitor>Bandwidth report constantly changes colors of reported
interfaces.

NSM-15397 Very slow performance when opening IPSec VPN page in NSM.

NSM-15340 Customer reported issue on Point to Point VPN configuration through NSM.

NSM-15274 There are still gaps in data usage seen for firewalls on NSM.

NSM-15147 Mismatch in data transferred between the Carrier report and NSM.

NSM-14687 GEN6 - Active tunnels tab does not display a created timestamp.

NSM-14612 NSM-Hub and Spoke Tunnel VPN Topology creates wrong route policies.

Version 2.3.4
August 2022

Compatibility and Installation Notes
l Most popular browsers are supported, but Google Chrome is preferred for the real-time graphics display
on the Dashboard.

l AMySonicWall account is required.
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What's New in NSM SaaS
l Zero Touch 2.0: It is a new microservices based architecture that simplifies on-boarding of firewalls and
establishes reliable connectivity between NSM and firewalls. Moving the firewalls to Zero-touch 2.0 will
require migration which will be done in phases by SonicWall and no action is required by customers.
SonicWall will inform you in advance when your account is selected for migration. You will receive a
notification email to your MySonicWall account.

l System Events for Generation 7 Firewalls: Administrators can now view the firewall System Event logs
in NSM. Please refer to the Reporting and Analytics Guide for more details. The following pre-requisites
are necessary to view and manage system events:

l NSM advanced license on firewalls.

l Only supported only for newly added device with Sonic OS 7.0.1-5080 or higher.

l Tenant and Group Level Custom Reports: Administrators can now build aggregated custom reports at
the tenant and firewall device group level.

l CIDR based Search: Administrators can look for a range of IP addressed within a CIDR in analytics data.
NOTE: Refer to "Known Issues" section for any known issues with these features. These issues will
be addressed in upcoming maintenance releases.

Resolved Issues - NSM SaaS
Issue ID Description

NSM-15101 Bandwidth report constantly changes colors of reported interfaces.

NSM-15100 Live monitor report fails to refresh at random.

NSM-15011 Suggestion to change the word "Analyzer" to "Analytics".

NSM-14826 Creating address object fails.

NSM-14737 NSM is not showing AWS integration option.

NSM-14730 NSM is unable to upgrade firmware on firewalls.

NSM-14699 NSM live report is not showing data of more than 3 days.

NSM-14694 Wrong application IDs used in NSM templates.

NSM-14514 Alert on Echo Reply when only high priority intrusion events is selected.

NSM-14418 Difference of access rules in NSM and firewall interface.

NSM-13949 NSM shows HA disabled with no serial number of standby unit but HA is
enabled on firewall.

NSM-13002 Getting an unknown reason error when trying to check the connection failure
list under Client DPI-SSL. The connection failure list is also empty.

NSM-12608 Only web domain report appears in the PDF when using the custom report rule to
get report on user specific web categories, web domain and web sites for last 30
days.
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Known Issues NSM SaaS
Issue ID Description

NSM-15340 Customer reported issue on point to point VPN configuration through NSM.

NSM-15274 There are still gaps in data usage for firewalls on NSM.

NSM-15265 Click to Show Details is not displaying the description.

NSM-15196 Unable to generate report on NSM and there is no data in charts.

NSM-15156 No data is showing in reports when checking below 6 hrs except in Web
Categories.

NSM-15147 Mismatch in data transferred between the carrier report and NSM.

NSM-15090 Search function of Web Categories>Web Activities reports is inconsistent.

NSM-14875 Active connection count on the SystemMonitor/Connection Usage shows
blank graph.

NSM-14829 ICMP Code , ICMP Type , Destination NAT IP and Session Type shows value
when in firewall the value is blank.

NSM-14794 Scheduled flow report type PDF has empty pages when some of the details
report has no data.

NSM-14750 Color coding does not show for the different types of system events.

NSM-14748 Search is not working for system events.

NSM-14667 App risk numbers in capture threat assessment report does not match NSM
flow report.

NSM-14612 Hub and Spoke Tunnel VPN topology creates wrong route policies.

NSM-14398 Applications blocked due to high risk on NSM is categorized as low priority on
the app control.

NSM-14355 Login to unit is not working for Gen6 with instant connect enabled.

NSM-7277 Wireless dashboard is missing information for Login to unit.

Additional References
NSM-12622, NSM-11582.
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Version 2.3.3-9
July 2022

Compatibility and Installation Notes
l Most popular browsers are supported, but Google Chrome is preferred for the real-time graphics display
on the Dashboard.

l AMySonicWall account is required.

Resolved Issues - NSM SaaS
Issue ID Description

NSM-14842 Unknown/Uncategorized entries in NSM SaaS web activities reports.

NSM-14762 NSM scheduled firmware upgrade on unit level error-upgrade failed.

NSM-14692 Gen6 unable to update enforce password complexity.

NSM-14689 Cannot click 'Next' in pop up dialogue when using 1440x795 resolution on
15,6" inch MacBook.

NSM-14685 Gen6 cannot create tunnel interface VPN or update it.

NSM-14684 Gen6 and Gen7 FQDN object creation with underscore in name is not
possible.

NSM-14682 Errors received when updating local user 'email_address is empty , password
has length greater than MAX_LEN '64'.

NSM-14664 Unable to create VLAN on switch connected to the firewall from NSM.

NSM-14636 Unable to enable VPN and getting error "Failed: auth_method.shared_secret_
secret has length greater than MAX_LEN '128".

NSM-14622 Bandwidth report constantly changes colors of reported interfaces.

NSM-14621 Live monitor report fails to refresh at random.

NSM-14511 Per interface alert displays the wrong interface within the alert. Alert is
configured for X1 but email and history show X0.

NSM-14510 Unable to configure email log automation only on firewall from NSM. Getting
error "failed:'automation.email_address.audit is empty'".

NSM-14456 Issue with live monitor showing only few interfaces in NSM.

NSM-14447 Customer wants to get all his firewalls and access points to be transferred
from secondary tenant to primary tenant.
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Issue ID Description

NSM-14442 Unable to see any data under productivity reports on NSM.

NSM-13007 Application signature description and virus description is stuck at loading for ID >
49000.

Known Issues NSM SaaS
Issue ID Description

NSM-14699 NSM live report not showing data for more than 3 days.

NSM-14687 Active tunnels tab does not display a created time stamp.

NSM-14667 App risk numbers in capture threat assessment report does not match NSM
flow report.

NSM-14612 Hub and spoke tunnel VPN topology creates wrong route policies.

NSM-14604 Time slot is full message while creating rule on NSM.

NSM-14398 Applications blocked due to high risk on NSM is categorized as low priority on
the app control.

NSM-14322 Application signature count is comparatively more in number in NSM than in
firewall.

NSM-14067 NSM detects good verdicts from Captre ATP as a virus.

NSM-13727 NSM not displaying correct admin name.

NSM-9327 Firewall view is not showing all the IPS signatures that are actually showing in the
firewall interface.

Additional References
NSM-14884, NSM-14761, NSM-14686, NSM-14595.

Version 2.3.3-8
June 2022

Compatibility and Installation Notes
l Most popular browsers are supported, but Google Chrome is preferred for the real-time graphics display
on the Dashboard.
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l AMySonicWall account is required.

Resolved Issues - NSM SaaS
Issue ID Description

NSM-14550 When the source address in the CFS policies from NSM is changed, the
priority of the policy changes its current value to 0.

NSM-14513 Unable to sort DHCP and ARP leases by search or vendor for Gen7 devices
on NSM.

NSM-14487 Receiving unit down email notification through CSC.

NSM-14448 Unable to enable “Ignore DF(Don't Fragment) Bit” in template/IP
Sec/advanced.

NSM-12702 Some sites do not show in NSM reporting and analytics.

Known Issues NSM SaaS
Issue ID Description

NSM-14699 NSM live report not showing data for more than 3 days.

NSM-14667 App risk numbers in Capture Threat Assessment report is not matching NSM
Flow report.

NSM-14664 Unable to create VLAN on switch connected to the firewall from NSM.

NSM-14636 Unable to enable VPN. Getting error message "Failed: auth_method.shared_
secret_secret has length greater than MAX_LEN '128'".

NSM-14604 Getting message "Time slot is full" while creating rule on NSM.

NSM-14512 NSM feature "Whitelist login IP addresses" does not block user access to
NSM tenant.

NSM-14456 There is issue with live monitor as it is showing only few interfaces in NSM.

NSM-13007 Application signature description and virus description stuck at loading for ID >
49000.

Additional References
NSM-14442, NSM-14612, NSM-14620, NSM-14682, NSM-14684, NSM-14685, NSM-14686, NSM-14687, NSM-
14689, NSM-14690, NSM-14692.
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Version 2.3.3-7
June 2022

Compatibility and Installation Notes
l Most popular browsers are supported, but Google Chrome is preferred for the real-time graphics display
on the Dashboard.

l AMySonicWall account is required.

Resolved Issues - NSM SaaS
Issue ID Description

NSM-14386 Gen7 firewall fails ZT acquisition in NSM. RPC errors in logs read "connection
reset by peer".

NSM-14275 Log download beta fails to download the saved log files with .gz.

NSM-14076 Cannot create log download rule when selecting range ending 48+hours prior
to current date.

NSM-14055 NSM inventory not updating new group info for firewall after deleting group.

NSM-14017 Secondary storage information on NSM does not show same information as
on firewall.

NSM-13998 Display error or notification when configuring CFS URI object.

NSM-13997 Cipher control blocking not working from template but works from firewall view.

NSM-13990 Email log automation is not been updated from template.

NSM-13963 Unable to create IPv4 access rule. Nested address group causes group object
to be identified as IPv6.

NSM-13750 Generating a CTA report fails with "Failed(Valid PDF download link is not
found in CTA Response. [serial no.])" in firewalls with NSM
Essential/Advanced license.

NSM-13735 Template was applied on the firewalls even when they're unchecked.

NSM-13374 Event logs filter not working.

NSM-13174 Mismtach in data transferred between the firewall Appflow report and NSM.

NSM-13047 NSM unable to upgrade firmware for manually acquired firewalls while ZT
works. The firmware successfully uploads to the firewall, but does not reboot.

NSM-12627 CTA report does not match threats in firewall.
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Issue ID Description

NSM-5969 Input validation should be done before allowing commit and deploy.

NSM-5751 Cannot see SSHmanagement rule in NSM after enabling it on interface.

NSM-5674 Software upgrade does not process.

NSM-805 FQDN address objects are able to be created but incorrectly.

Known Issues NSM SaaS
Issue ID Description

NSM-14513 Cannot sort DHCP and ARP leases by search or vendor for GEN7 devices on
NSM.

NSM-14511 Per interface alert displays the wrong interface within the alert. Alert
configured for X1, email and history show X0.

NSM-14510 Unable to configure email log automation on firewall from NSM. It gives error
"failed:'automation.email_address.audit is empty'".

NSM-14448 Unable to enable “Ignore DF(Don't Fragment) Bit” in template/IP
Sec/Advanced.

NSM-14447 Customer wants to get all his firewalls and access points to be transferred
from the secondary tenant to the primary tenant.

NSM-14398 Applications blocked due to high risk on NSM is categorized as low priority on
the app control.

NSM-14322 Application signature count is comparatively more in number in NSM than in
firewall.

NSM-14264 NSM live report not showing data more than 3 days.

NSM-14096 When firewall failover to secondary, the NSM doesn't show secondary firewall
but instead keeps showing as offline.

NSM-13909 Incorrect responder location is displayed in analytics data.

NSM-13656 Virus information cannot be viewed by the customer.

NSM-13007 Application signature description and virus description stuck at loading for ID >
49000.

NSM-9327 Firewall view is not showing all the IPS signatures that are actually showing in
the firewall interface.

NSM-7277 Wireless dashboard missing information.

Additional References
NSM-14342, NSM-14240, NSM-14029, NSM-13953, NSM-13534.
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Version 2.3.3-6
May 2022

Compatibility and Installation Notes
l Most popular browsers are supported, but Google Chrome is preferred for the real-time graphics display
on the Dashboard.

l AMySonicWall account is required.

What's New in NSM SaaS
l The following configurations are now exported as a part of Golden Template from a device:

l ARP

l DHCP server

l Network monitor

l SD-WAN

l Gateway anti-virus signatures

l Anti-spyware signatures

l Intrusion prevention signatures

l App control signatures

l Default service-objects, service-groups and schedules

l A new "Firmware upgrade progress bar" is added in the Upgrade Firmware wizard for administrators to
track the status of a firmware upgrade for a device.

Resolved Issues - NSM SaaS
Issue ID Description

NSM-14242 Data showing gaps between 1st-3rd April.

NSM-14148 Reporting data not showing up for all firewalls after starting a 365-day report.

NSM-14144 Adding management interface to template failed.

NSM-14095 Firewall displayed the message "Cannot fetch Licenses data. Register the
firewall in www.mysonicwall.com and activate NSM license".

NSM-14075 Firewall showing offline.
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Issue ID Description

NSM-14051 No data available in NSM from 4th-9th April for firewall.

NSM-14042 In NSM, there was no VPN information and no NSM license under "ZT,
Analytics and Reporting Status". Firewall has NSM advanced license.

NSM-14031 Firewall displayed the message "NSM Advanced is not licensed". Firewall has
NSM advanced license.

NSM-14000 Unable to login to NSM Capture Client portal.

NSM-13989 Data out of bounds error is displayed intermittently while trying to update
radius information using template.

NSM-13971 Customer is receiving schedule report for a tenant which is already deleted
from his account.

NSM-13965 GEN7 firmware upgrade when scheduled is not working through NSM SaaS.

NSM-13924 Tenant was deleted on MySonicWall but it still shows up on NSM.

NSM-13871 NSM showing incorrect GEO-IP location.

NSM-13861 Hit Counter/Usage value is different between NSM and firewall and the last
time hit value is not in user readable format.

NSM-13788 VPN green light missing on VPN's that are up. It affects Gen6 units.

NSM-13774 Need to add more hardware error.

NSM-13735 Template was applied on the firewalls even when they are unchecked.

NSM-13710 Not able to see any data under productivity reports on NSM.

NSM-13693 Service group is not showing the right setting.

NSM-13641 Hub and Spoke Tunnel VPN topology creates wrong route policies.

NSM-13630 Alert on echo reply when only high priority intrusion events is selected.

NSM-13569 When trying to pull report for more than 3 days from NSM for the firewall, it
times out with no data after few minutes.

NSM-13553 App Risk Level in Capture threat assessment report does not match the NSM
flow report.

NSM-13514 NSM Capture ATP feature doesn't exist on firewall.

NSM-13367 Alert is not triggering and logging in the dashboard.

NSM-13212 Reports in NSM got deleted when customer got RMA for the primary firewall.

NSM-12975 Internal error message shows while trying to push ip helper policy using
golden template.

NSM-12883 Clicking on All Tenants displays error "Empty Response of [put] to
[https://nsm-uswest.sonicwall.com/api/manager/tenats/active]".

NSM-12625 Unable to see all website activity for specific user on NSM.

NSM-12580 Reporting for GeoIP not showing correct data.

NSM-11311 Packet capture is not configurable in "Switch to Firewall Context".

NSM-10711 App control issues in template.
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Issue ID Description

NSM-6285 In Gen6 firewalls, the block/log for category of apps is not shown.

NSM-5722 OSPF neighbor status Icon missing in getRouteList.json?reqType=256.

Known Issues NSM SaaS
Issue ID Description

NSM-14322 Apps signature count is comparatively more in NSM from firewall.

NSM-14264 NSM live report is not showing data for more than 3 days.

NSM-14096 When firewall fails over to secondary, NSM doesn't show secondary firewall
but keeps showing primary instead as offline.

NSM-14076 Cannot create log download rule when selecting range ending 48+ hours prior
to current date.

NSM-14055 NSM inventory not updating new group information for firewall after deleting
group.

NSM-13997 Cipher control blocking is not working from template.

NSM-13990 Email log automation is not being updated from template.

NSM-13909 Incorrect responder location in analytic data is displayed.

NSM-13750 Generating a CTA report fails with "Failed(Valid PDF download link is not
found in CTA Response. [serial no.])" error in firewalls with NSM
essential/advanced license.

NSM-13656 Could view viruses earlier yesterday but could not do so after 6 PM yesterday.

NSM-13007 Application signature description and virus description is stuck at loading.

NSM-12627 CTA report does not match threats in firewall.

NSM-9327 Firewall view is not showing all the IPS signatures that are actually showing in
the firewall interface.

NSM-7277 Wireless dashboard is missing information.

Additional References
NSM-14094, NSM-13062, NSM-11324.
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Version 2.3.3-5-Hotfix1
April 2022

Compatibility and Installation Notes
l Most popular browsers are supported, but Google Chrome is preferred for the real-time graphics display
on the Dashboard.

l AMySonicWall account is required.

Resolved Issues - NSM SaaS
Issue ID Description

NSM-14154 IPv6 configurations in IP helper are not being handled properly.

NSM-14133 There is no report data in NSM SaaS.

NSM-14070 Hit Counter/Usage value doesn't show any data for Gen 6 firewalls when
checked from NSM.

NSM-13861 Hit Counter/Usage value is different between NSM and firewall and the "Last
Time Hit Value" is not in user readable format.

NSM-13715 Connections chart is not displaying any data prior to 3/7 date.

NSM-13583 Commit shows as scheduled when it was pushed to deploy now.

NSM-13261 Commits are stuck in scheduled state and doesn't deploy. Timing service fails.

NSM-12998 Data for the month of December is missing.

Known Issues NSM SaaS
Issue ID Description

NSM-13750 Generating a CTA report fails with "Failed(Valid PDF download link is not
found in CTA Response. [serial no.])" message in firewalls with NSM
essential/advanced license.

NSM-13630 Alerts received on echo reply when only high priority intrusion events is
selected.

NSM-13553 App risk level in Capture Threat Assessment report does not match NSM Flow
report.

52Network Security Manager Release Notes
SonicWall Network Security Manager 2.3



Issue ID Description

NSM-13174 Mismatch in data transferred between the firewall Appflow report and NSM.

NSM-13002 Checking the connection failure list under Client DPI-SSL throws an error as
an unknown reason and the connection failure list is empty.

NSM-12627 Capture Threat Assessment report does not match threats in firewall.

NSM-12625 Unable to see all website activity for specific user on NSM.

NSM-9327 Firewall view is not showing all the IPS signatures that are actually showing in
the firewall interface.

NSM-7277 Wireless dashboard is missing information.

Version 2.3.3-5
April 2022

Compatibility and Installation Notes
l Most popular browsers are supported, but Google Chrome is preferred for the real-time graphics display
on the Dashboard.

l AMySonicWall account is required.

What's New in NSM SaaS
l Exporting Device Configuration: Exporting a device configuration into a template workflow is improved
to remove commit errors. Please go through the golden template section in the NSM Administration Guide
to go through the enhancements.

l UI-based Validation for Variables in Templates: An error is thrown if an invalid input is entered for a
variable of a particular type.

Resolved Issues - NSM SaaS
Issue ID Description

NSM-13940 Template is not saving information about restrict to option for Capture ATP.

NSM-13888 Backlog data processing for 1st April to 3rd April.

NSM-13776 Customer is receiving schedule reports with different firewall names which
doesn't exist in their system.
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Issue ID Description

NSM-13756 No report data is visible in NSM for the firewalls.

NSM-13722 NSM live report is giving different graphical output, every time we refresh the
browser.

NSM-13592 Every refresh live report shows different graph when custom time is selected.

NSM-13584 Syslog server configuration deployment failed.

NSM-13513 Live Report: Clicking on the refresh button in the last 30 minutes inside NSM
page changes the graph/data each time.

NSM-13512 NSM live report is not showing data for more than 3 days.

NSM-13465 High CPU occurs on firewall while viewing policy page in NSM, due to multiple
post requests every 3 minutes.

NSM-13426 Address groups containing FQDN are identified in NSM as IP Version of
"IPv6", not IP version of "Mixed" for Gen7 NSv.

NSM-13425 Address group containing FQDN (Mixed IPv4/IPv6 type) is not displayed when
creating/modifying IPv4 routing rules.

NSM-13413 Variable formating for MAC field.

NSM-13412 Interfaces gets deleted when making any delete in template details.

NSM-13411 Configured interfaces is not included in commit or details.

NSM-13369 Unable to set management when DHCP is selected.

NSM-13347 Two commits are stuck in deploying.

NSM-13343 No data in NSM due to high backlog.

NSM-13287 When creating a new group with auto commit disabled, the auto commit gets
automatically enabled in the new group.

NSM-13262 Multicore monitor shows CPU usage greater than 100% on firewall added,
resulting in email alerts from NSM.

NSM-13102 Not able to see connection failure under DPI-SSL on NSM for multiple
firewalls.

NSM-13084 After applying golden template, changes which require a restart don’t show the
‘Restart Required’ option anywhere in NSM.

NSM-13078 Cannot create log download rule on Firewall view > Monitor > Log Download.

NSM-13061 Failed to apply access rule updates to Gen6 with golden template.

NSM-13056 Unable to set probe with tunnel interface on custom route.

NSM-12975 Internal error message appears while trying to push ip helper policy using
golden template.

NSM-12971 Must specify an explicit gateway, when using main mode error, while trying to
push group VPN setting using golden template.

NSM-12969 Failed to get handle for service object table while trying to push access rule
ipv4 using golden template.
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Issue ID Description

NSM-12968 Destination service failed to get handle error while trying to push access rule
ipv4 using golden template.

NSM-12967 Many source translations are not supported for NAT policy using golden
template.

NSM-12965 CFS profile allowed URLs that failed to get handled, when using golden
template.

NSM-12817 Issue with live monitor showing only X0 in NSM.

NSM-12676 Multiple template issue occurred while trying to use template without default
configuration.

NSM-12649 NSM showed that the license expired but no expired licenses are seen for this
unit.

NSM-12630 Network usage per interface alerts are being generated but not displayed on
NSMGUI, alert or email.

NSM-12624 Alerts and notifications > Rule page does not load or timeout.

NSM-12567 Intermittently, some of the live monitor charts does not show any data, despite
API responding with data.

NSM-12467 Read-only user could not see Capture ATP data.

NSM-10509 Network topology not displaying.

NSM-3967 Deleting a VAP profile shows success following commit, but the profile is not
removed. It happens when secondary HA unit is active in NSM.

NSM-3666 Unable to edit the VPN and 4 to 6 tunnel interface.

NSM-886 Editing routing rules through template is failing due to the ID of the route policy.

Known Issues NSM SaaS
Issue ID Description

NSM-14055 NSM inventory is not updating new group information for firewall after deleting
group.

NSM-13997 Cipher control blocking is not working from template. But it is working from
firewall view.

NSM-13990 Email log automation is not getting updated from template.

NSM-13989 Error for "Data out of bounds" shows intermittently, when trying to update
Radius information using template.

NSM-13750 Generating a CTA report fails with "Failed(Valid PDF download link is not
found in CTA Response. [serial no.])" message in firewalls having NSM
essential/advanced license.

NSM-13630 Received alert on Echo Reply when only high priority intrusion event is select.

NSM-13583 Commit shows as scheduled when it is pushed to deploy now.
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Issue ID Description

NSM-13553 App Risk Level in capture threat assessment report does not match NSM flow
report.

NSM-13514 Capture ATP feature doesn't exist on firewall.

NSM-13374 Event logs filter on Firewall View is not working.

NSM-13367 Alert is not triggering and logging in the dashboard.

NSM-13212 Reports in NSM get deleted when customer get RMA for the primary firewall.

NSM-13174 Mismatch in data transferred between the firewall Appflow report and NSM.

NSM-13007 Application signature description and virus description is stuck at loading.

NSM-12883 An error message shows when clicking on all tenants.

NSM-12702 Some sites do not show in NSM Reporting and Analytics.

NSM-12627 CTA report does not match threats in firewall.

NSM-12625 Unable to see all website activity for specific user on NSM.

NSM-12580 Reporting for GeoIP does not show correct data.

NSM-9327 Firewall view is not showing all the IPS signatures that are actually showing in the
firewall GUI.

Additional References
NSM-13743, NSM-13657, NSM-13516, NSM-13327, NSM-13326, NSM-12976, NSM-12626.

Version 2.3.3-4
March 2022

Compatibility and Installation Notes
l Most popular browsers are supported, but Google Chrome is preferred for the real-time graphics display
on the Dashboard.

l AMySonicWall account is required.

l Refer to either the on-premises or SaaS Network Security Manager Getting Started Guide for the latest
information on hardware requirements, operating systems, and browser levels.
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What's New in NSM SaaS
l Template Enhancements:
When a new device is added to an auto-commit-enabled device group that has a template with variables
previously applied to it, a resolve variables option is presented for the new device (NSM-10116).

1. When a new interface is created, the default address object for that interface is created
automatically.

2. When an existing interface is edited, the related address object for that interface is automatically
updated.

3. Zone creation in templates creates the zone subnets address group.

4. Variable support provided for configuring routing rules and for ethernet address in static range
configuration under DHCP server lease scopes.

5. Firewall fail-over and LB setting configuration is supported in templates.

6. Validation checks for IP addresses throw an error if an incorrect IP address is entered.

l New Filters on Commits Page: Four new filters have been added on the commit page under operational
status: Pending Approval, Approval Overdue, Approved and Rejected.

l Login to Unit: Login to unit opens in a new tab in browser.

l Automatic Commits: Commits are automatically created for the following operations on the firewall
inventory page:

1. License synchronization at the group level.

2. Flush ARP cache.

3. Rebooting at the group level.

Resolved Issues - NSM SaaS
Issue ID Description

NSM-13595 Addressed CVE-2022-0778.

NSM-13511 Moving all devices from In Group to Unassigned still shows resolve template
variable with empty screen.

NSM-13191 Unable to create access rules by selecting a sub-interface as "From" in NSM,
as the rule gets created for the parent interface.

NSM-13143 For few access rule, hit counter doesn't match between NSM and Firewall.

NSM-13117 Not able to make changes for syslog server format via NSM.

NSM-13058 Not able to deploy WAN failover changes on NSM.

NSM-13003 Acknowledging alerts or deleting fails on NSM.

NSM-12978 VPN green light missing on VPN's that are up. It affects Gen6 units.
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Issue ID Description

NSM-12958 When template is created without default configuration, we should not be
exporting default schedule setting.

NSM-12954 Customer is receving schedule report for a tenant which is already deleted
from his account.

NSM-12705 Not able see multiple core data under live-reports.

NSM-12688 OSPF Metric and TAG blank.

NSM-10062 Rejected commit stuck at the top of the list forever.

NSM-6089 While adding 2-3 "MD5-exclusions" , only 1 entry gets added in Capture ATP.

NSM-5727 IPHELPER > DHCPv6 does not show IPV6 value.

NSM-5607 No option to flush DNS cache in NSM.

NSM-5565 DNS server used is available in Gen 6 but NSM shows 'N/A' in gen 6.

Known Issues NSM SaaS
Issue ID Description
NSM-13426 Address groups containing FQDN are identified in NSM as IP Version of "IPv6",

not IP version of "Mixed".

NSM-13425 Address group containing FQDN (Mixed IPv4/IPv6 type) is not displayed when
create/modify IPv4 routing rules.

NSM-13287 When creating new group with auto commit disabled, it creates the group with
auto commit enabled.

NSM-13262 Multicore monitor shows CPU usage greater than 100% on firewall added,
resulting in email alerts from NSM.

NSM-13212 Reports in NSM got deleted when customer got RMA for the primary firewall.

NSM-13174 Mismatch in data transferred between the firewall Appflow report and NSM.

NSM-13061 Failed to apply access rule updates to Gen6 with golden template.

NSM-13007 Application signature description and virus description stuck at loading.

NSM-12971 Must specify an explicit gateway when using main mode error, while trying to
push group-VPN setting using golden template.

NSM-12883 Getting error while clicking on all tenants in NSM.

NSM-12630 Network usage per interface alerts are been generated but not been displayed on
NSMGUI or Alert or Email.

NSM-10509 Network topology not displaying.

NSM-9327 Firewall view is not showing all the IPS signatures that are actually showing in the
firewall GUI.

NSM-3967 Deleting a VAP profile shows success following commit, but profile is not removed. It
happens when secondary HA unit is active in NSM.
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Additional References
NSM-13263, NSM-10116.

Version 2.3.3-3
February 2022

Compatibility and Installation Notes
l Most popular browsers are supported, but Google Chrome is preferred for the real-time graphics display
on the Dashboard.

l AMySonicWall account is required.

l Refer to either the on-premises or SaaS Network Security Manager Getting Started Guide for the latest
information on hardware requirements, operating systems, and browser levels.

Resolved Issues - NSM SaaS
Issue ID Description

NSM-13153 No data after NSM Saas upgrade.

NSM-13152 Error while switching to firewall context.

NSM-12895 No data shown on live monitor.

NSM-12868 NSM live report not showing data more than 3 days.

NSM-12816 Logs out of NSM once we do LTU to Gen 7 device.

NSM-12706 NSM report showing 7 virus in 90 days but 23 in 30 days.

NSM-12703 NSM flow report - virus details No Data after a few days.

NSM-12648 Template - Importing cert for web management settings gives error "X-
DEVICE-ID header is not provided or is invalid".

NSM-12144 Firewall>Network>System>Interfaces, Group column does not display the
correct failover and LB members.

NSM-11618 NSMGUI firewall view does not show correct MTU value.

NSM-11512 Not able to edit security action profile from NSM.

NSM-9679 Support for template variables on routing page.

NSM-6823 No commit created when rebooting at group level.

NSM-5598 Click here to download the SSL VPN Zip file logs does not work.
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Known Issues NSM SaaS
Issue ID Description
NSM-13143 For few access rule, hit counter doesn't match between NSM and Firewall.

NSM-13078 Cannot create log download rule on Firewall view-Monitor-Log Download.

NSM-13061 Failed to apply access rule updates to Gen6 with golden template.

NSM-13056 Not able to set probe with tunnel interface on custom route.

NSM-13007 Application signature description and virus description stuck at loading.

NSM-12978 VPN green light missing on VPN's that are up; affects Gen6 units.

NSM-12975 Internal error message while trying to push ip helper policy using golden
template.

NSM-12971 Must specify an explicit gateway when using main mode error while trying to
push group-VPN setting using golden template.

NSM-12965 CFS profile allowed URLs failed to get handled, when using golden template.

NSM-12954 Customer is receving schedule report for a tenant which is already deleted from
his account.

NSM-12705 Not able see multiple core data under live-reports NSM.

NSM-12630 Network usage per interface alerts are been generated but not been displayed on
NSMGUI or alert or Email.

NSM-12623 Productivity report on NSM is empty or with very limited data.

NSM-11430 Unable to access user page using super admin user.

NSM-10509 Network topology not displaying.

NSM-9327 NSM firewall view is not showing all the IPS signatures that are actually showing
in the firewall GUI.

NSM-3967 Deleting a VAP Profile shows success following commit, but profile is not removed. It
happens when secondary HA unit is active in NSM.

Additional References for NSM SaaS
NSM-12970, NSM-12866, NSM-12821, NSM-12704, NSM-12629, NSM-12078, NSM-11976.
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Version 2.3.3-2
February 2022

Compatibility and Installation Notes
l Most popular browsers are supported, but Google Chrome is preferred for the real-time graphics display
on the Dashboard.

l AMySonicWall account is required.

l Refer to either the on-premises or SaaS Network Security Manager Getting Started Guide for the latest
information on hardware requirements, operating systems, and browser levels.

Resolved Issues - NSM SaaS
Issue ID Description

NSM-12628 No data is visible if limit is changed to 100 or above. Data only appears if limit
is 50.

NSM-12621 Mismtach in data transferred between the firewall flow report and NSM
reports.

NSM-12569 Increase TSR downlaod timeout value.

NSM-12466 Capture ATP showing 0%malicious files though there are 3 malicious files.

NSM-12450 Variable causes error in the user interface.

NSM-12419 Editing an IPv6 access rule results in Error: object access_rules ipv4 does not
exist.

NSM-12339 When adding DHCP scope on Gen6 devices while using pre-pop Interface,
with DNS Proxy enabled, DNS server entries are limited to 1.

NSM-12308 Cannot sort any column in ARP page GEN6 and GEN7 firewalls added to
NSM on NSM.

NSM-12307 Unable to sort DHCP leases by vendor on any GEN7 devices added to NSM
on NSM portal.

NSM-12288 Interface name is not displayed on editing a route policy created for VPN
tunnel interface.

NSM-12174 Cannot enable botnet filter on new or existing access rules.

NSM-12173 While creating multipath route using multiple tunnel interfaces, the additional
gateway configurations are not grayed out when tunnel interface is applied.
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Issue ID Description

NSM-12170 Capture ATP Exclusion (Block until verdict) fails when applying a group object
or setting to None.

NSM-12013 Not able to see Capture ATP information on NSM with NSM advanced license.

NSM-11906 The customer while trying to check the connection failure list under Client DPI-
SSL is getting an error as an unknown reason and the connection failure list is
empty.

NSM-11625 Code dump in diag page is not available in GEN 6 firewall.

NSM-11588 VTI Index of the interface: interface with the same name already exist when
modifying through NSM.

NSM-11506 On the Templates, the default address objects are not updated when an
interface IP is edited.

NSM-11505 On the Templates, the default address objects are not created when an
interface is added.

NSM-11503 On the Templates at Templates > Network > System > DHCP Server >
DHCP Scopes > Add Static, the variable selection option is missing for
Ethernet Address field.

NSM-10911 Multiple user interface issues on the Log Settings page were resolved.

NSM-9911 Capture client shows off in NSM for the firewall under status of the firewall.

NMS-6812 Logging in to a unit should open a new tab.

NSM-5723 OSPF Metric and TAG blank.

NSM-5719 DHCP shows blank for generic option when the value is 'None'.

Known Issues NSM SaaS
NSM-13061 Failed to apply access rule updates to Gen6 with golden template.

NSM-13007 Application signature description and virus description stuck at loading.

NSM-12978 VPN green light missing on VPN's that are up. This affects Gen6 units.

NSM-12975 Internal Error message while trying to push ip helper policy using golden
template.

NSM-12954 Customer is receiving schedule report for a tenant which is already deleted from
his account.

NSM-12868 NSM Live Report not showing data more than 3 days.

NSM-12705 Not able see multiple core data under live-reports NSM.

NSM-12703 NSM Flow Report - Virus details No Data after a few days.

NSM-12630 Network usage per interface alerts are been generated but not been displayed on
NSMGUI, Alert or Email.

NSM-12625 Unable to see all website activity for specific user on NSM.
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NSM-12623 Productivity report on NSM is empty or with very limited data.

NSM-12178 Mixed type address group is being identified by NSM as IPv6. Cannot
create/modify routing rules with mixed type group.

NSM-11512 Not able to edit security action profile from NSM.

NSM-11430 Unable to access user page using super admin user.

NSM-10509 Network topology not displaying.

NSM-9327 Firewall view is not showing all the IPS signatures that are actually showing in the
firewall GUI.

NSM-3967 Deleting a VAP Profile shows success following commit, but profile is not removed.
This happens when secondary HA unit is active in NSM.

Additional References for NSM SaaS
NSM- 12884, NSM- 12847.

Version 2.3.3-1
January 2022

Compatibility and Installation Notes
l Most popular browsers are supported, but Google Chrome is preferred for the real-time graphics display
on the Dashboard.

l AMySonicWall account is required.

l Refer to either the on-premises or SaaS Network Security Manager Getting Started Guide for the latest
information on hardware requirements, operating systems, and browser levels.

Resolved Issues - NSM SaaS
Issue ID Description

NSM-12093 NSM shows "Waiting for NSM to configure flow settings on the firewall through
commit workflow" even after commit is successful.

NSM-12091 Static DHCP entry is not correctly assigning to DNS settings.

NSM-11361 Browsing to VPN Topology -> Global Settings creates a permanent template.

NSM-11343 The status of VPN is not showing correctly on NSM.
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Issue ID Description

NSM-7277 Information missing onWireless Dashboard.

NSM-6413 Purge all is not working.

NSM-6326 VPN green light missing on 3/4 VPN's that are up.

NSM-5550 SSL VPN shows incorrect group routes.

NSM-191 After adding user under Device>Users>Local Users&groups> Local Users, default
value for idle timeout in Guest services tab is not getting reflected in firewall.

Version 2.3.3
January 2022

Compatibility and Installation Notes
l Most popular browsers are supported, but Google Chrome is preferred for the real-time graphics display
on the Dashboard.

l AMySonicWall account is required.

l Refer to either the on-premises or SaaS Network Security Manager Getting Started Guide for the latest
information on hardware requirements, operating systems, and browser levels.

What's New in NSM SaaS
l Device Management for Backup:When creating a backup schedule, NSM allows to select all the
devices in the inventory for backup.

What's New in Analytics
l Productivity Reports: Support for Productivity reports in scheduled reports.

Resolved Issues - NSM SaaS
Issue ID Description

NSM-12450 Variable causing errors everywhere in UI.

NSM-12069 Administrative settings issues.
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Issue ID Description

NSM-11829 Variable causing errors everywhere in UI.

NSM-11827 Storage shows up twice in the left pane in FWVIEW.

NSM-11814 NSM shows License Expired; NSM Essential has been renewed.

NSM-11678 NSM shows there are differences when no changes have been made to unit since it
last synced.

NSM-11659 API response for zones has wrong properties key.

NSM-11585 Acquiring Gen 7 device with existing "SGMSServer-VPN" tunnels deletes the other
VPN tunnels,address objects and Service Obj due to PUT request.

NSM-11325 NSM pushing template with SMTP server for Automation, password did not push
over correctly.

NSM-11198 Enabling SSH on VLAN interface causes the default NAT rule to disappear.

NSM-11061 Address Objects created in VPNWizard fails to get committed in Firewall.

NSM-11038 Undefined is seen in signature name.

NSM-10961 Configuration Difference between NSM and Firewall.

NSM-10916 Cannot add interface to Failover and LB group "Name in Body Required".

NSM-10907 "Source Port Remap" option is mislabeled in NSM for Gen7.

NSM-10904 Acknowledging Alerts or deleting does not update until screen is refreshed.

NSM-10898 Address object created does not show up in VPN access list.

NSM-10891 Incorrect values found in Log group settings for Gen6 devices.

NSM-10856 Unable to create multiple Address Objects by just changing the name and IP as the
save button gets grayed out.

NSM-10726 Administrative settings issues.

NSM-10717 Changing stealth mode changes Internal VLAN.

NSM-10713 Capture ATP issues in templates.

NSM-10704 Address object getting saved causes the save button to get grayed out in FW View
and Template View.

NSM-10703 Slow UI when NSM on-prem loads 2000 Firewalls.

NSM-10610 Export of inventory missing critical data.

NSM-10591 API call for low priority attacks is not seen in template details.

NSM-10551 Increase timeout for firmware upload for group firmware upgrade.

NSM-10508 Error on access rule priority change.

NSM-10505 Upgrade status icon showing up on NSM Version 2.3.1-R8-H2 and never goes
away.

NSM-10461 Unable to edit the group or event in log setting screen.

NSM-10440 Templates > Address Objects - VPN zone randomly missing when creating objects.

NSM-10405 Multiple Template issue on Geo-ip Filter page.

NSM-10369 No response from accept button while editing the VAP Object.
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Issue ID Description

NSM-10368 Error on access rule priority change using template.

NSM-10348 Scheduled firmware upgrade icon is missing on NSM 2.3.1 version.

NSM-10070 The App Rule and CFS rule creation not working from session logs.

NSM-10061 Address object update is failing with invalid argument error

NSM-9422 Scheduled reboot (group action) immediately reboots the device.

NSM-9158 Unable to increase the Virtual AP client limit for SOHO250W through NSM.

NSM-8355 Acquisition fails when the exp of the firewall > 20MB.

NSM-8295 Failover and LB config show incorrect values on firewall and NSM.

NSM-7596 On navigating to App Rule and clicking on Delete All throws error as "no app_
rules.policy found".

NSM-7162 HTTPS port is not configurable in NSM, both firewall and template affected.

NSM-7104 Not able to see CATP information on NSM with NSM Essential License.

NSM-6824 Cannot delete certificate from FWView with errors.

NSM-6416 Service Groups references do not load.

NSM-6408 Link aggregation system ID is incorrect.

NSM-6407 Statistics, edit, LLDP profiles missing in L2 Discovery.

NSM-6339 VLAN creation workflow does not have flow reporting on by default.

NSM-6333 Failover and LB reset statistics is not working.

NSM-5626 Setting TTL on split DNS server does not work.

NSM-5596 Enable OSCP shows enabled even when it is disabled.

NSM-5594 VPN displaying 0.0.0.0 and missing crypto suite information for some tunnels.

NSM-5592 UI options that are not supported in NSv are showing up.

NSM-5560 Bug in ZT up-time syntax.

NSM-5550 SSL VPN shows incorrect group routes.

NSM-5546 Incorrect value shown for Admin user.

NSM-5123 1 pending config shown in all tenants even if there isn't one.

NSM-5119 CSC Users > STATUS only shows logged in users in 'All Tenants' or the default
tenant.

NSM-4364 The firmware upgrade is not happening from inventory and firewall setting page.

NSM-3970 Deleting a VAP Object while Secondary HA unit is active shows successful, but
VAP object is not deleted from firewall.

NSM-3967 Deleting a VAP Object while Secondary HA unit is active shows successful, but
profile is not removed.

NSM-3687 Firewall view > Home screen shows security services disabled despite being
enabled.

NSM-1178 Address object gets removed from address group when the address object's name
is edited.
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Issue ID Description

NSM-754 AP packet capture page not implemented.

NSM-191 After adding user, default value for idle Timeout in Guest services tab is not getting
reflected in firewall.

Resolved Issues - Analytics
Issue ID Description

AAR-2569 Scheduled Monthly reports are coming blank for the month of October,2021.

AAR-2532 UI is listing NSM Essential and Advanced screens when the group has firewalls with only
one type of license.

AAR-2479 The Bandwidth queue report shows only real time queue.

AAR-2204 The PDF reports generated in NSM do not match info seen in NSMMonitor.

AAR-2182 Daily report sent to the recipient even when report not scheduled.

AAR-2086 Alerts are not being generated in Notification Center or Archived or Email.

AAR-1951 Live Monitor doesn't display all WAN interfaces on NSM, whereas it shows all interfaces on
the firewall.

AAR-1949 Live Report shows blank content for some fields intermittently.

Known Issues NSM SaaS
Issue ID Issue Description

NSM-12173 While creating Multipath route using multiple Tunnel Interfaces, the additional
Gateway configs are not grayed out even when Tunnel Interface is applied.

NSM-12093 NSM shows "Waiting for NSM to configure flow settings on the firewall through
commit workflow" even after commit is successful.

NSM-12091 Static DHCP entry is not correctly assigning DNS settings.

NSM-12078 Unable to import a CA certificate to a firewall via NSM.

Error is received stating: :"Improper file format. Please select PKCS#12 (*p12)
file.".

NSM-11906 List under Policy>Client DPI-SSL>common name>show connection
failures>Error-Unknown Reason, is empty.

NSM-11343 VPN status not showing correctly on NSM.

NSM-10509 Network topology is not displayed when navigated to Network Topology from the
Home screen interface.

NSM-9327 NSM-Firewall view does not show all the IPS signatures that are showing in the
firewall GUI.
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Issue ID Issue Description

NSM-7277 Wireless Dashboard is missing some information.

NSM-7104 Not able to see Capture ATP information on NSM with NSM Essential License.

Known Issues - Analytics
Issue ID Issue Description

AAR-2883 Unable to see all website activity for specific user on NSM.

AAR-2084 Network Usage per Interface alerts are being generated but not being displayed on NSMGUI or
Alert or EMAIL.

Additional References for NSM SaaS
NSM-12112, NSM-11736, NSM-11677, NSM-11662, NSM-11431, NSM-11039, NSM-10911, NSM-10835, NSM-
10532, NSM-10274, NSM-10056, NSM-10036, NSM-9779, NSM-7774, NSM-3405.

Additional References for Analytics
AAR-2718, AAR-2701, AAR-2605, AAR-2572, AAR-2478, AAR-2281, AAR-2085, AAR-2031, AAR-1178.

Version 2.3.2-Hotfix 7
December 2021

Compatibility and Installation Notes
l AMySonicWall account is required.

l Most popular browsers are supported, but Google Chrome is preferred for the real-time graphics display
on the Dashboard.

l Refer to either the on-premises or SaaS Getting Started Guide for the latest information on system
requirements, operating systems, and browser levels.
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Resolved Issues - NSM SaaS
Issue ID Description

NSM-12258 CVE-2021-42550 patch for NSM SaaS.

Version 2.3.2-Hotfix 6
December 2021

Compatibility and Installation Notes
l AMySonicWall account is required.

l Most popular browsers are supported, but Google Chrome is preferred for the real-time graphics display
on the Dashboard.

l Refer to either the on-premises or SaaS Getting Started Guide for the latest information on system
requirements, operating systems, and browser levels.

Resolved Issues - NSM SaaS
Issue ID Description

NSM-12209 Log4j Infinite Loop Recursion.

Version 2.3.2-Hotfix 5
December 2021

Compatibility and Installation Notes
l AMySonicWall account is required.

l Most popular browsers are supported, but Google Chrome is preferred for the real-time graphics display
on the Dashboard.
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l Refer to either the on-premises or SaaS Getting Started Guide for the latest information on system
requirements, operating systems, and browser levels.

Resolved Issues - NSM SaaS
Issue ID Description

NSM-12163 Upgrade Log4j to 2.16.0 for NSM SaaS.

Version 2.3.2-Hotfix 3
December 2021

Compatibility and Installation Notes
l AMySonicWall account is required.

l Most popular browsers are supported, but Google Chrome is preferred for the real-time graphics display
on the Dashboard.

l Refer to either the on-premises or SaaS Getting Started Guide for the latest information on system
requirements, operating systems, and browser levels.

Resolved Issues - NSM SaaS
Issue ID Description

NSM-11829 Variable causing errors everywhere in UI.

NSM-11678 NSM shows there are differences when no changes have been made to the unit, since it
last synced.

NSM-9422 Scheduled reboot(group action) immediately reboots the device.

Resolved Issues - Analytics
Issue
ID Description

AAR-
2687

Generating a CTA report fails with "Failed(Valid PDF download link is not found in CTA Response.
[serial no.])"in firewalls with NSM Essential/Advanced license.
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Version 2.3.2-Hotfix 2
December 2021

Compatibility and Installation Notes
l AMySonicWall account is required.

l Most popular browsers are supported, but Google Chrome is preferred for the real-time graphics display
on the Dashboard.

l Refer to either the on-premises or SaaS Getting Started Guide for the latest information on system
requirements, operating systems, and browser levels.

Resolved Issues - NSM SaaS
Issue ID Description

NSM-11798 Access denied error appears when accessing any firewall on NSM.

NSM-11467 Address objects created in VPN wizard fails to get committed in firewall.

NSM-11445 VPN wizard pushes incorrect zones for protected networks for Hub and Spoke.

NSM-11252 Incorrect HA status on inventory page.

NSM-10912 WAN group VPN shared secret is displayed incorrect on NSM(not same as in the
firewall).

NSM-10348 Scheduled firmware upgrade icon is missing on NSM 2.3.1 version.

NSM-5123 1 pending configuration shown in all tenants even if there isn't one.
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Version 2.3.2-Hotfix 1
November 2021

Compatibility and Installation Notes
l AMySonicWall account is required.

l Most popular browsers are supported, but Google Chrome is preferred for the real-time graphics display
on the Dashboard.

l Refer to either the on-premises or SaaS Getting Started Guide for the latest information on system
requirements, operating systems, and browser levels.

What's New in NSM SaaS
l Commit enhancement: Allows user to cancel an in-progress Commit when at least of the targeted
devices in the Commit is unmanaged or unreachable.

l Updated Analytics: Integrates the latest next generation Analytics features and enhancements. See
details below.

l Maintenance: Addresses bugs submitted since last release.

What's New in Analytics
l Tenant and Group level reports: Includes tree view for displaying the tenant and group hierarchy, drill
down capabilities from tenant and device summary reports, and API support.

l Scheduled Report Support: Added for tenant and group level reporting.
l Maintenance: Addresses bugs submitted since last release.

Resolved Issues - NSM SaaS
Issue
ID Description

NSM-
11062

The VPNWizard pushes the incorrect zones for protected networks for Hub and Spoke.

NSM-
11060

Once an address group iscreated with the VPNWizard, it doesn't show up in drop down list.
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Issue
ID Description

NSM-
10974

NSM is not correctly showing the Secondary Active firewall.

NSM-
10922

NSM loses device status from time to time.

NSM-
10913

If one of the DNS Settings fields on Firewall View > Network > DNS > Settngs is left empty,
you receive a warning about an invalid IP address.

NSM-
10777

Adding a routing rule from template fails for Gen7 firewall.

NSM-
10461

Unable to edit the Group or Event in log setting screen in the Templates section.

NSM-
9984

Initiating a Group Action to upgrade firmware for GEN7 firewalls is not working on NSM.

NSM-
9782

Moving a unit from unassigned to the Root group throws an error in UI "Device '<name>' (Serial
Number: <serial_number>) cannot be migrated from the wrong Device Group (input
GroupID=<value>, found GroupID=<value>)"

NOTE: In the message above, <value> is replaced by the actual value of that variable.
NSM-
9666

Shows the messageWaiting for NSM to configure flow settings on the firewall through
commit workflow even after the Commit is successful.

NSM-
9608

When downloading reports from Capture Security Center (CSC), the downloaded report does
not show the right data.

NSM-
7264

Scheduled Reports for CTA is failing for NSM firewalls licensed with both Essential and Advanced
lisences.

Resolved Issues - Analytics
Issue ID Description

AAR-
2562

Client scheduled reports are stuck in queue for multiple customers.

AAR-
2458

NSM doesn't show data when it isGrouped by Signatures.

AAR-
2445

When exporting a Flow Report to PDF, the following error is displayed: Cannot read
properties of undefined (reading 'lable').

AAR-
2402

After un upgrade to NSM 2.3.2-R8, the Source VPN and Destination VPN fields in the
Details section has no data.

AAR-
2112

When scheduled, the Real-Time Monitor report fails with the message No report data
found.)

AAR-
2081

Cannot create CFS policies from the Productivity group—CFS policy button is missing.

73Network Security Manager Release Notes
SonicWall Network Security Manager 2.3



Issue ID Description

AAR-
1993

For firewalls with an NSM Essential license, the start time shows the up time of a firewall.

AAR-
1992

CTA report generation is not consistent and cannot be reproduced.

AAR-
1906

The scheduled report for a custom time range beyond 30 days from the current date behaves
inconsistently.

Known Issues - NSM SaaS
Issue ID Description

NSM-
11325

When pushing a template that includes SMTP server information for automation, the
password did not push over correctly.

NSM-
11198

Enabling SSH on VLAN interface causes the default NAT rule to disappear.

NSM-
11045

A delay may be experienced when setting up VPN for NSM Advanced firewalls due to GW
firewalls not being in sync with NSM.

NSM-
10961

When a configuration different is noted between NSM and the firewall, an error is displayed:
t.commits is undefined.

NSM-
10916

Cannot add interface to Failover and LB group.

NSM-
10912

WANGroup VPN shared secret is displayed incorrectly on NSM; it doesn't match the
firewall.

NSM-
10704

Saving an Address Object causes the save button to get greyed out in Firewall View and
Template View.

NSM-
10509

Network topology is not displaying.

NSM-
10405

Multiple template issues appear on Geo-IP Filter page.

NSM-
10368

Error on access rule priority change in template.

NSM-
10070

The App Rule and CFS rule creation are not working from session logs.

NSM-
10061

Address Object update are failing with invalid argument error.

NSM-
9422

Scheduled reboot (group action) immediately reboots the device.

NSM-
9327

Firewall view is not showing all the IPS signatures that are actually showing in the firewall
interface.
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Issue ID Description

NSM-
9158

Unable use NSM to increase the Virtual AP client limit for SOHO250W.

NSM-
7850

CTA cannot be generated in LTU mode.

NSM-
7277

Wireless Dashboard is missing information.

NSM-
7104

Not able to see Capture ATP information on NSM with NSM Essential License.

Known Issues - Analytics
Issue ID Description

AAR-2532 PDF reports generated by NSM do not match with the data displayed in the NSM user
interface.

AAR-2459 Some data is duplicated in theMONITOR view on Summary > Blocked and Details >
Blocked screens.

Additional References for NSM SaaS
AAR-2310, NSM-11151, NSM-10561

Version 2.3.2
October 2021

Compatibility and Installation Notes
l Most popular browsers are supported, but Google Chrome is preferred for the real-time graphics display
on the Dashboard.

l AMySonicWall account is required.

l Refer to either the on-premises or SaaS Network Security Manager Getting Started Guide for the latest
information on hardware requirements, operating systems, and browser levels.
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What's New in NSM SaaS
l Switch configuration in templates: Helps to configure common switch configurations such as Network
(IPv4, DNS, etc.), Users (add, delete, etc.), Radius Server, Voice VLAN etc for SonicWall Switches. Only
static switch configurations are supported.

l Variable support in VPN topology: Helps to simplify and optimize the VPN topology creation in NSM.
Variables such as address objects can used to define protected networks in common configurations and
device specific values can be assigned to these variables during application.

l Alert Notification Enhancements: Helps to customize the alerts in NSM using the revamped Settings
Screen. Users can manage alerts such as device connectivity, firmware upgrade status, commit status,
and user authentication using this. Users can enable or disable alerts based on the requirements.

What's New in Analytics
l Custom Filters and Flow Log Type: Helps to create Log Download rules for a firewall using a custom
filter. Users can filter data for Flow Log Type into All Traffic, Blocked, and Threats.

Resolved Issues - NSM SaaS
Issue ID Description

NSM-10557 Custom Service Groups are missing in the Service Group list within templates.
NSM-10507 Creating custom access rule or editing the existing rule throws the error Source

and destination cannot be of different IP version.

NSM-10504 Wireless type zone (for example, WLAN) is not editable in Firewall view.
NSM-10417 NSM throws error on changing priority in Template.
NSM-10339 Template does not save the DNS server IPs on the DNS | Settings screen.
NSM-10336 New Enhancement: Ability to cancel a commit that failed because the device is

unmanaged or offline.

NSM-9945 Unable to see active user's group membership on Device | Users | Status
page.

NSM-9741 The Ping option throws the error Diagnostic action failed at processing at the
firewall, please try again later continuously on the Diagnostics | Ping screen

NSM-9576 Emails from nsmalerts@nsm-uswest.sonicwall.com are getting blocked by the
spam filter.

NSM-9499 TheGeo IP, Intrusion Prevention and Anti Spyware settings are not getting
saved.

NSM-9443 Bypassing SSO for Group-address object fails on theOBJECT | Users |
Settings | SSO Method Configuration screen.
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Issue ID Description

NSM-9302 Interface name is not displayed after editing a route policy created for VPN
tunnel interface on Firewall | Policy | Route Policy.

NSM-9284 The Template View | Log Settings screen throws the error, Schema
validation error: unknown property trap, for Gen7 while committing and
deploying edits.

NSM-9277 References are stuck in loading or referencing objects are not displayed on the
Firewall View | Objects | Address Group | References screen.

NSM-9274 Schedule Commit and Deploy does not work properly for Device Certificates.
NSM-9218 Source address on the default HTTPS Management access rule is not

displayed correctly after configuring within template on the Template View |
Policy | Rules and Policies | Access Rules screen.

NSM-9120 Filtering to Custom NAT rules does not work if the name is blank.

NSM-8894 Exporting firewall logs from NSM does not export all entries.

NSM-8786 Template lockout and timeout change fails for NSM.

NSM-8599 NSM Firewall view shows different configurations than the actual configuration
in firewall even after synchronizing the firewall with NSM.

NSM-8525 Configuring the route policy throws the error Interface value is unreasonable.

NSM-8445 Restart chassis screen is not available in NSM for supermassive unit.

NSM-8400 Template variable created for Domain Name does not work on the Network |
Interface | Add or Edit Interface screen.

NSM-8261 NSM 2.1.0R0012- DPI-SSL settings shows incorrect name.

NSM-8138 SD-WAN Probe information does not display in NSM for ZT firewall if the
object name contains space.

NSM-8064 NSM 2.2.1 shows incorrect HA status.

NSM-7862 Acknowledging or deleting Alerts fails on nsm-uswest.sonicwall.com.

NSM-7805 Editing NAT policy fails with the error Command 'no reflexive' does not match
on Policy | Rules and Policies | NAT Rules screen.

NSM-7655 LDAP import of user shows only first letter of user name and last of domain
name.

NSM-7124 Unable to remove or add countries in global list forGeo-IP Settings.
NSM-6819 Global search function does not work for Login to Unit.
NSM-6475 NSM is not sending correct VPN settings to GW FW and to Client FW.

NSM-5886 Deleting All SLA Class Object throws an error path
/api/manager/firewall/sdwan/all-sla-class-objects was not found.

NSM-5396 On Users screen, editing the tenant admin details throws error Please select
Role and Tenant under Access Tab.

NSM-5195 Clicking Save fails with JS error after making config in TACACS Users tab.
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Issue ID Description

NSM-5069 Column preferences are not saved in Microsoft Edge properly. The same
sequence works fine in Chrome and Firefox.

NSM-4539 SonicPoint Monitor is not showing information.

NSM-4243 IP validation is missing while creating the VAP profiles.

NSM-4162 The CSV export of logs does not export for the full timeframe chosen

NSM-3882 NSM sends scheduled report emails to the tenant's user ID when the firewall is
not present for the tenant.

NSM-2689 Force One Time Password gets enabled after creating a Local User
NSM-2142 The ARP cache are not being displayed in NSM on Network | System | ARP |

Static ARP screen.

NSM-941 Failures in acquisition if Pref size crosses a certain point.

Resolved Issues - Analytics
Issue ID Description

AAR-2239 Reporting and Analytics configuration gets stuck on the NSM side.

AAR-2144 NSM Report is not showing data for the Total category.

AAR-2112 Real-time monitor reports for a firewall throws the error No report data found.

AAR-2007 Include web categories and websites in custom report group criteria thus to enable the
users to generate web analytics report for a specific user.

AAR-1931 Log download does not contain website data.

AAR-1897 Unable to see report based on SRC or DST countries.

AAR-1896 NSM does not display information as required, on the Live Monitor page.
AAR-1828 There is mismatch of data between the CTA report generated from the firewall and the one

generated from NSM.

AAR-1710 Web category-based alerts are not working.

AAR-1049 Network usage alerts are not getting reported.

Known Issues NSM SaaS
Issue ID Issue Description

NSM-10405 TheGeo-IP Filter page throws multiple template issues.
NSM-10368 Access rule priority change in template throws error.

NSM-10359 GUIDs are not matching between KVM Console and NSM.

NSM-10061 Address object update fails with invalid argument error.
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Issue ID Issue Description

NSM-9422 Scheduled reboot either fails or immediately reboots the device for Gen7 devices.

NSM-9327 NSM Firewall view is not showing all the IPS signatures that are showing in the firewall GUI.

NSM-9158 Unable to increase the Virtual AP client limit only for SOHO 250W through NSM.

NSM-8295 Failover and LB config show incorrect values on firewall and NSM.

NSM-7104 Customer with NSM Essential License is not able to see CATP information on NSM.

NSM-4625 NSM does not acquire HA device when secondary device is active.

NSM-3970 Deleting a VAP Object while Secondary HA unit is active fails.

Known Issues - Analytics
Issue ID Issue Description

AAR-2204 PDF reports generated by NSM do not match with the data displayed in the NSM user
interface.

AAR-2086 Alerts are not being generated in Notification Center as required.
AAR-2081 The Create CFS Policies option is missing on the Productivity Groups screen.
AAR-1993 CTA reports provide the reports since device is up, and not for the required period.

AAR-1992 CTA report generation is not consistent.

AAR-1951 Live Monitor does not display all WAN interfaces on NSM, whereas it shows all interfaces
on firewall.

AAR-1906 Scheduled reports fail and shows no data even when there is data.

AAR-1315 The VPN tunnel creation task fails when VPN rule is pushed with Manual priority.

Additional References for NSM SaaS
NSM-10468, NSM-10288, NSM-9997, NSM-9566, NSM-9281, NSM-9180, NSM-9179, NSM-9049, NSM-8884,
NSM-8841, NSM-8722, NSM-8621, NSM-7953, NSM-7599, NSM-7209, NSM-4380.
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Version 2.3.1
August 2021

Compatibility and Installation Notes
l Most popular browsers are supported, but Google Chrome is preferred for the real-time graphics display
on the Dashboard.

l AMySonicWall account is required.

l Refer to Network Security Manager for OnPrem and SAAS- System Requirements for the latest
information on hardware requirements, operating systems, and browser levels.

What's New in NSM
l Login to Unit (Gen 6/6/5 Firewalls): Allows users to directly log into SonicOS on a firewall and check the
configuration in a read-only mode. User can login without authentication.

l VPN Wizards Enhancements: Allows users to create VPN configuration for Full Mesh, Partial Mesh, and
Point-to-Point deployments.

l Device Certificate Management: Automates the process of the firewall certificate management lifecycle
- request, retrieval, and renewal.

l Common Access Card (CAC) Support: Allows common access card (CAC) support for user/admin
authentication on NSMOn-Premise.

What's New in Analytics
l Custom Reports: Helps provide end-to-end flow so that you can create custom reports using data
already available in the analytic system. You can create customized time graphs and report tables.

Resolved Issues - NSM
Issue ID Description

NSM-9446 For templates SSLVPN Access toggle is getting grayed out, if SSLVPN
access is not enabled while creating the zone.

NSM-9338 The VPN and Flow commits do not get created by NSM (ISA) FRA.
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Issue ID Description

NSM-8935 Zero Touch port config reverts to 21021 following reboot, after set to 21021,
443.

NSM-8746 The Log > Settings screen shows no data.
NSM-8701 NSM gets unregistered after importing Signature Files for Closed Network.

NSM-8595 Configuring template variable for PPPoE/L2TP/PPTP Domain Name throws
the error Please enter a valid Domain Name.

NSM-8555 Some fields are not getting updated correctly for RBL Filter > Template view.
NSM-8508 Selecting template variable for domain name throws error on the Network >

Interface > Add or Edit Interface > DHCPmode.

NSM-8408 Unable to add 4to6 Tunnel Interface on the Network > Interface page.
NSM-8383 CONFIGURE LTE/5G fails to commit and throws error.

NSM-8318 Provide sorting option onGroup Firmware Upgrade screen.
NSM-8289 The DHCP Scope does not reflect the changes made on Templates > System >

interfaces. The Firewall View edits also fail to reflect.

NSM-8261 DPI-SSL settings shows incorrect name compared to firewall.
NSM-8245 Changing the excluded address for SonicWall CFS shows schema validation

error after Commit and Deploy for Gen7 
NSM-8222 On the DPI SSL Enforcement page, the default values are missing.
NSM-8216 The created DHCP Server does not show in the table.

NSM-8187 Adding Virtual interface for SD-WAN Architect fails commit for GEN7.
NSM-8074 Error while deleting Zone inObject > Zones.
NSM-8067 Enabling the Toggle button shows an error message for VLAN trunking.
NSM-8060 The Update button for Edit is not working for SD-WAN route policy in

Template mode.
NSM-8010 Delete All option for NSM > DHCP over VPN is throwing error for the central

gateway.

NSM-7604 NSM incorrectly identifies Local Users with@ in the domain user name, due to
which unable to edit users.

NSM-7596 Selecting App Rule and clicking on Delete All throws the error No app_
rules.policy found.

NSM-7556 Download SSO auth Log is not working on the Diagnostics > Tech Support
Report page.

NSM-7203 NSM does not show correct CATP location info.

NSM-7064 Include firewall information for Firewall License Info in closed network
structure.

NSM-6950 After adding Address, Service Objects, orGroups, the entries do not appear
in the address field or in the drop down.
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Issue ID Description

NSM-6935 The Zone fields for both Source and Destination are missing on the Editing
Rules page for security policies.

NSM-6820 Scheduling backup times are not in order.

NSM-6686 Clone DHCP Scope shows Inherit DNS when Specify Manually is selected
NSM-6596 NSM configs do not push down to NSa 3700. Also getting redeploy errors.

NSM-6504 Scheduled Reports > Add Schedule > Delivering Configuration tab throws
the error Cannot read property ID of undefined.

NSM-6133 The DPI SSL Client SSL common name are listed as undefined in NSM for
Gen6.

NSM-5888 Adding SDWAN Path Selection Profiles throws the error Cannot read
property 'status' of undefined

NSM-5590 For Schedule Reports, the report for web categories is failing with the error No
Report data found. [2CB8ED693540] even when the report is present.

NSM-5314 Choosing Initialize Modem Connection Using AT Commands is not
reflecting in UTM for 3G/4GModem Settings.

NSM-5085 Template to edit default WAN rules for management fails to deploy for GEN6.

NSM-4450 On the Policy > Capture ATP > Settings page, while adding MD5 exclusion
settings throws the error Empty Response of [get] to [https://cscmaqa-
uswest.eng.sonicwall.com/api/manager/firewall/capture-atp/md5-exclusions].

NSM-4444 On the High Availability > Advanced page, the synchronize firmware is
throwing context deadline/upstream request timeout error.

NSM-3968 Modifying the name of a Virtual Access Point Object in NSM results in two
VAP's when the secondary HA unit is active.

NSM-3966 Modifying a VAP Profile fails with error when the secondary HA unit is active.

NSM-2956 On the NSMOn-Premises Access Points > Wi-Fi Multimedia page, the
WMM does not get deleted from NSM and firewall, after the commit and deploy.

NSM-2689 The force one time password gets enabled after creating a Local user.

NSM-2142 On the Network > System > ARP page, the ARP caches are not being
displayed.

NSM-893 On the Network > SD-WAN > Rules page, the IP Version tag for the names (for
example, IPv4) disappears when name length of the entries is more.

Resolved Issues - Analytics
Issue ID Description

AAR-1781 Changing left hand navigation name from Scheduled Reports to Reports, Report Rules,
and Saved Reports.

AAR-1094 Network Usage per Interface alerts are improper
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Issue ID Description

AAR-1086 NSM Capture Threat Assessment report does not show Capture ATP data.

Known Issues NSM
Issue ID Issue Description

NSM-9443 For theObject > Users > Settings, SSOmethod configuration for bypassing SSO for
Group-address object is failing.

NSM-9327 NSM-Firewall view is not showing all the IPS signatures that were actually showing in the
firewall GUI

NSM-9281 Unable to add comment to WAN interface, the deploy fails.

NSM-9218 Source address of the default HTTPS Management Access Rule is not displayed correctly
after configuring within template

NSM-9158 Unable to increase the Virtual AP client limit for SOHO250W through NSM.

NSM-8502 Cannot Configure VLAN over Wire Mode. The paired interface does not get displayed in
SDWANOrchestrator.

NSM-8138 SD-WAN probe information does not display in NSM for ZT firewall If the object name
contains space.

NSM-8064 NSM shows incorrect High Availability status.

NSM-7862 Acknowledging or deleting alerts fail on NSM (nsm-uswest.sonicwall.com).

NSM-7753 Changes made to CFS Profile Object categories appear randomly.

NSM-7673 Unable to TSR from NSM. Multiple customers are affected.

NSM-7306 NSM does not use the SSL TLS option even if we configure for Notification.

NSM-7148 Importing Root CA certificate throws the error Invalid file format.

NSM-7124 Unable to remove/add countries from global list in Geo-IP settings.

NSM-7104 Not able to see CATP information on NSM with NSM Essential License.

NSM-6526 When acquiring a new appliance to NSM on-prem via ZT and moving from a default tenant
to another tenant, the appliance stays red.

NSM-3970 Deleting a VAP Object while Secondary HA unit is active shows successful, but VAP object is
not deleted from firewall.

Known Issues - Analytics
Issue ID Issue Description

AAR-1931 The Log download does not contain website data.

AAR-1897 Unable to see report based on SRC/DST country.

AAR-1710 Web category based alerts are not working.
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Additional References for NSM
NSM-8317, NSM-7994, NSM-7953, NSM-7369, NSM-4171.

Additional References for Analytics
AAR-1530, AAR-1344, AAR-1343, AAR-1335, AAR-1265, AAR-1194, AAR-1179, AAR-1106, AAR-1095.

Version 2.3
June 2021

Compatibility and Installation Notes
l Most popular browsers are supported, but Google Chrome is preferred for the real-time graphics display
on the Dashboard.

l AMySonicWall account is required.

l Refer to Network Security Manager for OnPrem and SAAS- System Requirements for the latest
information on hardware requirements, operating systems, and browser levels.

What's New
l Template Variables: Allows administrators to create variable objects during template configuration and
assign device specific value during template application.

l VPN Topology & Monitoring: Centralizes and simplifies the configuration of VPN settings and policies
through an easy wizard-based step-by-step set-up process. It also monitors the traffic going through VPN
tunnels.

l SD-WAN Design Studio: Deploy and monitor an enterprise-wide SD-WAN network by using an intuitive
self-guided workflow. Centrally establish and enforce application-based traffic and other traffic steering
configurations across and between thousands of sites.

l NSM Wizards : Configure NSM quickly through wizards - Setup Guide, VPN guide to create site-to-site
VPN policies, SD-WAN guide to create SD-WAN rules, Wireless Setup for WLAN configurations.
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Resolved Issues - NSM
Issue ID Description

NSM-4337 SWS Portshield shows Unassigned even after selecting ANY.
NSM-4355 Monitor screen is missing in the list in CSC Users > Roles and Permissions screen.
NSM-4750 When home tab is disabled, Home > Summary group is still accessible for the user.
NSM-4766 Edit option for admin user with Super Admin role to be made available.

NSM-5034 Normal reload does not use cookies/cache.

NSM-5165 Few fields inGateway AV Config View, 'Configure' dialog are not updated.
NSM-5889 Interfaces & HA - Virtual IP screens doesnot display ens192 interface details.

NSM-6032 Exporting 'Country Objects' data to a .CSV file does not work and the file doesn’t
download.

NSM-6325 Roles > System - High Availability screens are not added to Roles&Permissions list.
NSM-6506 While committing SSL VPN, gives an error as Exit Status 1.
NSM-6616 After acquisition of ZT device, it gives an "Acquisition Failed, context deadline

exceeded" for GEN7 device.
NSM-6838 Schedule report sends multiple daily report in a day with previous month's data instead of

previous day.

NSM-6928 The network - Interface page is giving error "cannot read property "map" of undefined".
NSM-7208 NSM unit acquisition failure code 1 "failed to sync config with device".
NSM-7226 Unable to see Pending Commits while logged as multi -admin user.

NSM-7227 Difference in notification center and Viewing Template Status.

NSM-7282 Unable to use Special character for shared_secret for VPN.

NSM-7345 Unable to modify WAN to WAN rule from NSM cloud.

NSM-7390 LDAP Auth does not work when used with "Allow Only AD Group Members"Option
NSM-7505 In CSC Users screen, Edit and Delete is grayed out for the default roles.

NSM-7577 Unable to change DNS from NSM.

NSM-7714 UI is displaying Standby node as ACTIVE after upgrade to 2.2.1 in HA screen.

NSM-7762 While performing Multi Upgrade on ZT unit throws error as "Response file null is not
available."

NSM-7799 Unable to restrict guest Users from editing Firewall > Backup as there is no option to
restrict.

NSM-7860 Exporting Logs results in the error "e is undefined".
NSM-8004 Gen6 firewalls stays on config mode.

NSM-8005 NSM constantly pushes syslog configuration for Gen6 firewalls.

NSM-8063 Error while forwarding ZT request for Gen 6 Device in NGA.
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Issue ID Description

NSM-8119 Downloading TSR throws error "Did not find the filename while attempting download".
NSM-8318 Provide Sorting option on Group firmware upgrade screen.

Resolved Issues - Analytics
Issue ID Description

AAR-1131 Firewall has data in NSM, but shows no web activity in the past 6 hours.

AAR-1132 Unable to see reports if selected range is more than 7 days.

AAR-1148 Unable to see list of blocked web sites.

Known Issues - SAAS NSM
Issue ID Issue Description

NSM-886 In Templates screen for Policy>Routing Rules, editing routing Rules through template is
failing with an error 'The ID of the route policy: Policy name duplicate'.

NSM-1061 Editing existing route policy is creating duplicate routes.

NSM-3882 NSM sends scheduled report emails to Tenant's user ID where the firewall is not present in
the tenant.

NSM-3974 In IPSec VPN > Settings > VPN Tunnel Statistics does not show any data.

NSM-5085 Template to edit defaultWAN > WAN rules for management fails to deploy for GEN6.
NSM-5751 Cannot see SSHmanagement rule in NSM after enabling it on interface.

NSM-6089 While adding 2-3 "MD5-exclusions", only 1 entry gets added in Capture ATP.
NSM-7104 Not able to see CATP information on NSM with NSM Essential License.

NSM-7203 CATP Location info is not in sync with NSM.

NSM-7655 LDAP import of user shows only first letter of user name and last of domain name.

NSM-7760 Uploading Firmware in Inventory is throwing success message but not upgrading the
device.

NSM-7805 Policy > Rules and Policies > NAT Rules screen, editing NAT policy fails with
"Command 'no reflexive' does not match" error.

NSM-8064 Incorrect HA status on NSM.

NSM-8187 Adding Virtual interface for SD-WAN Architect fails commit for GEN7.
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Known Issues - On Prem NSM
Issue ID Issue Description

NSM-6526 When moving from “default tenant” to another tenant, the appliance stays red.

NSM-7035 Users imported from LDAP/AD are not correctly displayed for Approval Groups; only User
Role is displayed.

NSM-7148 Error on CA Certificate Import.

NSM-7203 CATP Location info is not in sync with NSM.

NSM-7604 NSM incorrectly identifies Local Users with '@' in the name as a Domain user, due to which
unable to edit users.

NSM-7805 Policy > Rules and Policies > NAT Rules screen, editing NAT policy fails with
"Command 'no reflexive' does not match" error.

NSM-7898 Closed Network: Gen7 acquisition fails with few errors.

NSM-8074 InObject > Zones screen, it gives an error while deleting Zone.
NSM-8187 Adding Virtual interface for SD-WAN Architect fails commit for GEN7.

Known Issues - Analytics
Issue ID Issue Description

AAR-1049 Network usage alerts are not getting reported.

AAR-1086 NSM Capture Threat Assessment report doesn't show Capture ATP data.

Resolved Tickets Opened by Customers
NSM-6501, NSM-7208, NSM-7227, NSM-7260, NSM-7369, NSM-7392, NSM-7412, NSM-7702, NSM-7718,
NSM-7799, NSM-7849, NSM-8063, NSM-8106, NSM-8198, NSM-8318, NSM-8645.
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SonicWall Support
Technical support is available to customers who have purchased SonicWall products with a valid maintenance
contract.

The Support Portal provides self-help tools you can use to solve problems quickly and independently, 24 hours a
day, 365 days a year. To access the Support Portal, go to https://www.sonicwall.com/support.

The Support Portal enables you to:

l View knowledge base articles and technical documentation

l View and participate in the Community forum discussions at
https://community.sonicwall.com/technology-and-support.

l View video tutorials

l Access https://mysonicwall.com

l Learn about SonicWall Professional Services

l Review SonicWall Support services and warranty information

l Register for training and certification

l Request technical support or customer service

To contact SonicWall Support, visit https://www.sonicwall.com/support/contact-support.
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About This Document
NOTE: A NOTE icon indicates supporting information.

IMPORTANT: An IMPORTANT icon indicates supporting information.

TIP: A TIP icon indicates helpful information.

CAUTION: A CAUTION icon indicates potential damage to hardware or loss of data if instructions
are not followed.

WARNING: A WARNING icon indicates a potential for property damage, personal injury, or death.

Network Security Manager Release Notes
Updated - November 2023
232-005713-00 Rev ZZ

Copyright © 2023 SonicWall Inc. All rights reserved.

The information in this document is provided in connection with SonicWall and/or its affiliates’ products. No license, express or implied,
by estoppel or otherwise, to any intellectual property right is granted by this document or in connection with the sale of products.
EXCEPT AS SET FORTH IN THE TERMS AND CONDITIONS AS SPECIFIED IN THE LICENSE AGREEMENT FOR THIS
PRODUCT, SONICWALL AND/OR ITS AFFILIATES ASSUME NO LIABILITYWHATSOEVER AND DISCLAIMS ANY EXPRESS,
IMPLIED OR STATUTORYWARRANTY RELATING TO ITS PRODUCTS INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTY OFMERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT. IN NO EVENT
SHALL SONICWALL AND/OR ITS AFFILIATES BE LIABLE FOR ANY DIRECT, INDIRECT, CONSEQUENTIAL, PUNITIVE,
SPECIAL OR INCIDENTAL DAMAGES (INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF PROFITS, BUSINESS
INTERRUPTION OR LOSS OF INFORMATION) ARISING OUT OF THE USE OR INABILITY TO USE THIS DOCUMENT, EVEN IF
SONICWALL AND/OR ITS AFFILIATES HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. SonicWall and/or its
affiliates make no representations or warranties with respect to the accuracy or completeness of the contents of this document and
reserves the right to make changes to specifications and product descriptions at any time without notice. and/or its affiliates do not
make any commitment to update the information contained in this document.

For more information, visit https://www.sonicwall.com/legal.

End User Product Agreement
To view the SonicWall End User Product Agreement, go to: https://www.sonicwall.com/legal/end-user-product-agreements/.

Open Source Code
SonicWall Inc. is able to provide a machine-readable copy of open source code with restrictive licenses such as GPL, LGPL, AGPL
when applicable per license requirements. To obtain a complete machine-readable copy, send your written requests, along with
certified check or money order in the amount of USD 25.00 payable to “SonicWall Inc.”, to:

General Public License Source Code Request
Attn: Jennifer Anderson
1033 McCarthy Blvd
Milpitas, CA 95035
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